
Keyboard Shortcuts

CyberPilot Pro provides keyboard shortcuts for actions that otherwise require you to use the 
mouse. Where these keystrokes are equivalent to a menu command, they appear in the menu 
following the command name. In many cases there are three ways to access a menu command. 
For example, to display the Open File dialog box, you can do any of the following:

· Choose File|Open with the mouse.
· Press Alt+F to display the menu, and then press O to execute the command.
· Press Ctrl+O (the keyboard shortcut).

The following table lists the keystrokes that are in effect at all times.

Menu command Keystroke Description

File|New Map Ctrl+N Opens the New Map dialog box 
where you can enter the URL of 
the site you want to map.

File|Open Ctrl+O Opens the File dialog box where 
you can choose

File|Save Ctrl+S Saves the current file

WebMap|Explore Ctrl+X Opens the Explore dialog box 
where you can limit pages and 
levels to explore and verify links 
to other sites.

Ctrl+H Hides all routes to the selected 
object, whether or not you have 
the Properties dialog box 
displayed on your screen.

Alt+R Hides all routes to the selected 
object when the Properties 
dialog box is active.

Alt+L Hides all alternate routes to the 
selected when the Properties 
dialog box is active.



Menu Commands

Chose from the following list for information on a menu command:

File menu
View menu
WebMap menu
Object menu
Window menu
Help menu
Toolbar buttons
Shortcut menu



File menu commands

The File menu offers the following commands:

Command Description

New Map Creates a new NetCarta WebMap from a URL..

Open Displays the Open dialog box where you can open an 
existing WebMap.file.

Close Closes an opened WebMap file.

Save Saves an opened WebMap using the same WebMap 
file name.

Save As Saves an opened WebMap file to a specified file name.

Publish Displays the Publish dialog box where you can publish 
WebMaps that you’ve created.

Recently 
opened 
WebMap file

Displays the most recently opened WebMap file.

Exit Exits the CyberPilot Pro WebMap.



View menu commands

The View menu offers the following commands:

Command Description

Display Options Displays the Display Options dialog box where 
you can enter and change how objects are 
displayed in the NetCarta WebMap.

Labels Displays the Labels dialog box where you enter
and change how objects are labeled.

Browser 
Configuration

Displays the Browser Configuration dialog box 
where you enter your Browser of choice and 
can sync up the WebMap with the Browser.

Toolbar Shows or hides the toolbar. When a checkmark
is visible next to the Toolbar menu item, the 
Toolbar is displayed on the map window.

Status Bar Shows or hides the status bar at the bottom of 
the map window. As you move the mouse 
pointer over the menu items, brief descriptions 
appear in the status bar. When a checkmark is 
visible next to the Status Bar menu item, the 
Status Bar information is displayed.

Expand Expands the currently visible WebMap to the 
level of your choice, listed in a submenu.



WebMap menu commands

The WebMap menu offers the following commands:

Command Description

Explore Displays the Explore dialog box where you can set 
limit levels and verify links to other sites.

Search Displays the Search dialog box where you enter 
criteria for searching through WebMaps.

Compare/Update Displays the Compare/Update dialog box where you 
compare WebMaps to see what has changed.

Statistics Displays the Statistics dialog box where you can view
statistics about the WebMap.



Object menu commands

The Object menu offers the following commands:

Command Description

Launch Browser Opens your Browser and displays the page of the 
object you selected in the WebMap.

Expand from Here Expands the WebMap from the selected object to the
level of your choice, listed on a submenu.

Explore from Here Explores the WebMap from the selected object.

Goto Main Route Goes to the main route of the selected object.

Make Main Route Makes the selected object become the main route.

Properties Displays the Properties dialog.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of
multiple documents in the application window:

Command Description

Cascade Arranges map windows in an overlapped and 
diagonal fashion.

Tile Arranges map windows in vertical, non-overlapped 
tiles.

Arrange Icons Arranges icons of closed windows.

Close All Closes all the open map windows.

<open windows> Shows a list of all open map windows and has a 
check-mark next to the most recently-opened 
window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with the CyberPilot 
Pro application:

Command Description

Index Offers you an index to topics on which you can get 
help.

Contents Displays the CyberPilot™ Pro contents screen.

Using Help Provides general instructions on using the CyberPilot 
Pro Help system.

About Displays version and licensing information about 
CyberPilot™ Pro.



Toolbar buttons

The Toolbar offers the following buttons:

Creates a new map file from a URL.

Opens an existing map file.

Saves the current map file with the current file name.

Changes which objects are displayed in the WebMap

 Changes the labels used for the displayed objects.

Adds objects to the map.

Searches for specified objects in the WebMap.

Compares two maps or updates one map from another map.

      Displays map statistics.

Shows properties of the selected object.

Displays the CyberPilot™ Pro contents screen.



Shortcut menu

If you click the right mouse button on an object or link icon, a menu appears. This menu contains 
the same commands as the Object menu:

Command Description

Launch Browser Opens your Browser and displays the page of the 
object you selected in the WebMap.

Explore from Here Expands the WebMap from the selected object to 
the level of your choice, listed on a submenu.

Expand from Here Explores the WebMap from the selected object.

Goto Main Route Goes to the main route of the selected object.

Make Main Route Makes the selected object become the main 
route.

Properties Displays the Properties dialog.



Publishing NetCarta WebMaps

Publish NetCarta WebMaps to share with others
By publishing WebMaps of your favorite sites, you can share the maps with other CyberPilot Pro 
users. CyberPilot Pro helps people navigate quickly to the information they're looking for—they 
won't have to click through multiple levels of material and then click back again if they've taken 
the wrong route. For people who spend a lot of time browsing the Web, either as part of their jobs
or for their own personal use, cutting down on their browsing time helps them be more 
productive.

Publish WebMaps in a customized, compressed version
You can specify what types of objects you want to publish so that your published map focusses 
on the area of the Web site that you want it to. Published NetCarta WebMaps are compressed 
and include, among other things, any notes you’ve entered. If you have your own Web site, you 
can easily incorporate NetCarta WebMaps into your Web site by adding WebMap icons and links 
to your HTML pages. You can even set up a default NetCarta WebMap that will automatically 
appear any time another CyberPilot Pro user tries to map your site.

Publish multiple WebMaps for different users
Most large Web sites contain information about multiple areas of interest. For example, a 
corporate site could have information about the company and its products, job listings, future 
trends, order entry, technical support, and so on. To help people navigate quickly to the 
information they're interested in, you could publish a WebMap for each area in a site, including 
links to other areas with related information.

Submit your WebMaps to the NetCarta WebMap repository
The NetCarta Web site includes a repository of WebMaps. Some of the maps have been created 
by the NetCarta cyberspace cartographers, but many have been created by enthusiastic 
CyberPilot Pro users. You can use any of the WebMaps in the repository, as well as submit 
WebMaps that you’ve created of your favorite sites. The map repository is growing daily, so 
check it often for new NetCarta WebMaps, and keep those WebMaps coming.

RELATED TOPICS
Publishing and sharing NetCarta WebMaps
Publishing tips and techniques
Charting new ground: Advanced map making



Publishing and sharing NetCarta WebMaps

Publishing NetCarta WebMaps lets you share the maps you create with friends, co-workers, or 
the Web community at large. A published WebMap contains only the parts of a site you choose, 
and it’s compressed for easy transmission. You can send your NetCarta WebMaps to friends on a
diskette or through e-mail, or put WebMaps on your department’s internal Web server. You can 
even submit your maps for publication in NetCarta’s WebMap repository, where any CyberPilot 
Pro user can have access to it.

RELATED TOPICS
To publish a NetCarta WebMap
To use NetCarta’s WebMap repository
Charting new ground: Advanced map making
Publishing tips and techniques
What gets saved in a published NetCarta WebMap



To publish a NetCarta WebMap

When you publish a NetCarta WebMap, you create a customized, compressed version of the 
map. You use the Publish dialog box to set up the types of objects you want to include in the 
published version of the WebMap. Object types that you don’t include are deleted from the 
published map.

Before publishing a WebMap, take a look at Publishing tips and techniques, and What gets saved
in a published NetCarta WebMap.

To publish a WebMap, do the following:

1. Open the WebMap that you want to publish.

2. Choose Publish from the File menu.. The Publish dialog box appears.

3. In the Publish To box, specify the path and file name for the published map. You can use the 
Browse button to help determine the path and file name. The WMP extension will be 
appended automatically to the file name.

4. Decide which types of objects you want to include in the published version of the map. By 
default, the settings in the Publish dialog box match the WebMap’s current display options. 

5. If you want to use the alternate default settings that you set up yourself (see the next step), or 
those that ship with CyberPilot Pro, click Load Default. The alternate default settings are 
different from the initial defaults (matching your current display options).

6. If you want to save the current settings as the alternate defaults, select Save As Default. Doing
so overwrites the NetCarta alternate default settings. From now on, when you click Load 
Default, the Publish dialog box displays your saved settings.

7. Click OK. The WebMap is compressed and saved with the name you specified. You can now 
share the published WebMap with other CyberPilot Pro users or include it as part of your own 
Web site.

RELATED TOPICS
What gets saved in a published WebMap
To use NetCarta’s WebMap repository
Publishing tips and techniques



What gets saved in a published NetCarta WebMap

The following chart describes which objects and notes are included in the published version of a 
NetCarta WebMap:

Saved in published map Specified object types in explored regions of 
the WebMap, regardless of whether objects 
are currently visible
Label settings
Display option settings
Notes

Not saved in published map Objects filtered out due to the current publish 
options
Objects that are individually hidden using the 
Properties dialog box

RELATED TOPICS
Showing or hiding types of objects
Showing or hiding individual objects
To create and view notes
Display Options dialog box
Labels dialog box
Properties dialog box
Publishing and sharing NetCarta WebMaps
To use NetCarta’s WebMap repository
Publishing tips and techniques



To use the NetCarta WebMap™ repository

The NetCarta Web site, at www.netcarta.com, includes a WebMap repository where you can 
find interesting maps for public use. If you’ve created a NetCarta WebMap that you’d like to share
with others, you can submit it for publication to the repository. 

To get a WebMap from the repository, click the Maps button on the NetCarta home page.

To submit a NetCarta WebMap for publication in the repository, e-mail a saved WebMap (rather 
than a published version) to maps@netcarta.com. You should save the WebMap in such a way 
that at least one level beyond the home page is expanded.

If the map looks interesting, we’ll publish it. NetCarta reserves the right to make any necessary 
changes to the WebMap before publishing it, including renaming it to conform to the MS DOS 
naming convention.

RELATED TOPICS
To publish a NetCarta WebMap
Charting new ground: Advanced map making



Publishing tips and techniques

CyberPilot™ Pro lets you customize a NetCarta WebMap™ before publishing it. This section 
describes some of the things you may want to consider before publishing a map. If you come up 
with some useful tips that aren’t included here, we’d love to hear from you. You can e-mail your 
publishing tips to us at maps@netcarta.com.

Show few object types. The easiest WebMaps to use are those that have the simplest 
appearance. For that reason, consider showing only pages, or pages with only one or two other 
object types. Use the Display Options dialog box to restrict the visible object types.

Hide broken links. Use the Search dialog box to search for broken links. Then use the 
Properties dialog box to hide the individual broken links. You should try clicking the question mark

 icons of red objects at least once to verify that the links to these objects are truly broken. 

Hide unnecessary alternate routes, especially those to the home page. Many Web sites are set up 
so that you can return to the home page from every page in the site. Because navigating is so easy using 
a WebMap, these alternate routes to the home page are unnecessary. Use the Display Options dialog 
box to hide alternate routes.

If you do show alternate routes, consider setting them to unexpandable. Doing so keeps 
WebMaps from becoming cluttered as users navigate through them. If users want to navigate 
through an unexpandable object, they can select the object and choose Goto Main Route from 
the Object menu. Use the Display Options dialog box to make alternate routes unexpandable.

Hide objects that aren't useful for the intended user. If you’re creating separate WebMaps for 
different areas of a site, you should hide branches of the map hierarchy that aren’t related to the 
specific topic areas. Use the Properties dialog box to hide objects.

Hide unexplored objects. If unexplored areas of the WebMap aren’t important for your intended 
user, you may want to hide objects with question mark  icons. Use the Properties dialog box to 
hide unexplored objects.

Use descriptive labels for objects. Use the Properties dialog box to specify descriptive names in the 
Name fields of individual objects (the default name is the object’s title, which may or may not be a useful 
description). Then use the Labels dialog box to set labels to the Name field.

Use descriptive labels for objects. Use the Properties dialog box to specify descriptive names 
in the Name fields of individual objects (the default name is the object’s title, which may or may 
not be a useful description). Then use the Labels dialog box to set labels to the Name field.

Set up preferred routes. Determine if other routes to objects are more direct than the current 
main routes, and use the Make Main Route command to change those to be the main routes. 
You can then publish the WebMap without alternate routes. Use the Publish dialog box to 
eliminate alternate routes in the published map.

Attach notes. A brief synopsis of each object can help WebMap browsers decide whether or not 
they want to look at a particular object. By helping users be more selective about what they look 
at, notes help cut down Web server access-time even further. Use the Properties dialog box to 
create notes.

RELATED TOPICS



To make a map of NetCarta WebMaps
To create and view notes
Changing how objects are labeled
Showing or hiding types of objects
Showing or hiding individual objects
Viewing and changing object properties



Charting new ground: Advanced map making

If you have your own Web site, you can make NetCarta WebMaps an integral part of the site. 
CyberPilot Pro includes WebMap icons that you can include as part of your home page, or any 
page in the site for that matter. CyberPilot Pro visitors to your site can click the WebMap icon to 
display your NetCarta WebMap. You can create simple WebMaps of your site, or you can create 
maps of maps that focus on content areas from any number of other Web sites. You can even set
up your site so that any CyberPilot Pro user who tries to map your site will automatically get your 
customized NetCarta WebMap instead.

RELATED TOPICS
To add a NetCarta WebMap to your Web site
To make a map of NetCarta WebMaps
To add a default WebMap to your Web site



To add a NetCarta WebMap to your Web site

There are a variety of ways to incorporate NetCarta WebMaps into your own Web site. For 
example, you can have a single WebMap of your entire site, or you can have several maps for 
the various topic areas of your site. NetCarta provides WebMap icons that you can add to your 
HTML pages for linking to your WebMaps. 

Use these general instructions for incorporating a NetCarta WebMap into your Web site. 
(These instructions are not intended as a lesson in building HTML pages.)

1. Locate the NetCarta WebMap icon files—called MAPICO12.GIF, MAPICO16.GIF, and so on—
in your CyberPilot Pro installation directory. They should be in a subdirectory called PUBLISH.
Alternatively, you can download the icons from the NetCarta Web site by clicking the Maps 
button on the NetCarta home page (www.netcarta.com).

2. Copy the icon file you want to use into your Web site’s equivalent of a graphics directory.

3. In your HTML page, create an image tag for the WebMap icon and a link from the icon to the 
actual WebMap. For example, the link from a NetCarta WebMap icon to the map 
"mymap.wmp" might look like this in your HTML page: 

<A HREF="../maps/mymap.wmp"><IMG SRC="../icons/mapico16.gif" BORDER=0></A>

4. If you haven’t done so yet on your server, configure WMP as the APPLICATION/WEBMAP 
MIME type. You only need to configure the MIME type once. See your server documentation 
for information on configuring MIME types.

RELATED TOPICS
To publish a NetCarta WebMap
To make a map of NetCarta WebMaps
To add a default WebMap to your Web site



To make a map of NetCarta WebMaps
If you have your own Web site, you can create a map of maps for people who visit your site. A 
map of maps is a NetCarta WebMap that includes other NetCarta WebMaps. These types of 
WebMaps are useful when you want to create a single WebMap of various sites that focus on 
some common area of interest—skiing, for example.

To make a map of maps, you create a Web site with a page (or pages) that references your 
published, subject-area WebMaps. Then, you map your site, creating a map of maps. If you 
include this meta-WebMap in your site, visitors can simply double-click the NetCarta WebMap 
icon to display the map of other WebMaps. You’ll have made Web surfing (or skiing!) that much 
easier.

Create the WebMaps:

Create and customize WebMaps of the sites you want to include in the meta-WebMap. Then 
publish each WebMap, assigning a descriptive name to each one. For example, skiing-related 
WebMaps could have names such as RESORTS.WMP, DOWNHILL.WMP, XCOUNTRY.WMP 
and so on.

Create your Web site:

Depending on how complex your subject area is, you could reference all of the WebMaps from a 
single HTML page, or you could construct a multi-level site. Using the skiing example, you could 
have one page of WebMaps for downhill skiing, one for cross-country skiing, one for Swiss 
resorts, one for Colorado, and so on.

Because a WebMap’s default label for an HTML page is the page’s TITLE, give each page in the 
site a descriptive TITLE. That way, visitors to your site will have a good idea of what each map is 
about. (If you don’t want to use the TITLE for the label, you can always change the Name field in 
the Properties dialog box for the individual pages and WebMap objects.)

For each WebMap you want to include in your meta-WebMap, put an HREF on the appropriate 
HTML page to link to the WMP file, followed by an IMG tag for the clickable WebMap icon. 
(WebMap icons were installed in the PUBLISH subdirectory of your CyberPilot Pro installation 
directory. Alternatively, you can download the icons from the NetCarta Web site by clicking the 
Maps button on the NetCarta home page.) For example, to reference a WebMap called 
DOWNHILL.WMP, the HTML code would look something like this:

<A>HREF="../maps/downhill.wmp"><IMG SRC="../icons/mapico16.gif" BORDER=0></A>

Map the site:

Use the New Map command to map your site. This creates the meta-WebMap. In the meta-
WebMap, use the Display Options dialog box to turn on the display of WebMaps. If necessary, 
customize the labels in the meta-WebMap so that users can quickly find the WebMap they want.

To do so, use the Properties dialog box to specify descriptive names for the WebMaps, and then 
use the Labels dialog box to assign the Name label to objects of type Other.

Publish the meta-WebMap:

Use the Publish dialog box to publish the meta-WebMap. In the Publish Only list, select 
WebMaps, leaving everything else deselected. You now have a map of maps.



RELATED TOPICS
To publish a NetCarta WebMap
Creating a new WebMap
Changing how objects are labeled
To add a NetCarta WebMap to your Web site
To add a default WebMap to your Web site



To add a default WebMap to your Web site

If you have your own Web site, you can set it up so that your own NetCarta WebMap 
automatically appears whenever a CyberPilot Pro user tries to map the site. There are two 
reasons why you might what to do this. First, when CyberPilot Pro explores a Web site (by way of
the Explore command ), it sends a crawler into the site to determine its structure and content. By
creating a default NetCarta WebMap of your site, you prevent some of the traffic congestion that 
can occur when crawlers explore a site.

The other advantage of setting up a default NetCarta WebMap for your site is that you have more
influence on your visitor’s experience of the site. You control how objects are displayed in the 
WebMap; you can hide certain objects if you want to and set up the labels so they are as 
informative as possible. You can also include notes that help visitors choose what they want to 
see.

To set up a default NetCarta WebMap for your Web site, do the following:

1. Make a copy of your published WebMap, and name the copy DEFAULT.WMP.

2. Put the DEFAULT.WMP file in the root directory of your site (the directory containing the home 
page).
When another CyberPilot Pro user explores the site, CyberPilot Pro first looks for a 
DEFAULT.WMP file in the root directory. If it finds one there, the explore operation does not 
occur and the default WebMap is displayed instead.

3. If you haven’t done so yet on your server, configure WMP as the APPLICATION/WEBMAP 
MIME type. You only need to configure the MIME type once. See your server documentation 
for information on configuring MIME types.

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
To publish a NetCarta WebMap
To add a NetCarta WebMap to your Web site



 Searching and Comparing NetCarta WebMaps™

Search for simple text strings or set up complex search criteria
Searches of a NetCarta WebMap™ can be as simple as identifying all objects in the map with a 
particular text string in their names. Or, they can be as complex as searching for HTML pages in 
the currently visible map that have a particular modification date and a particular text string in 
their URLs.

You can specify advanced search criteria to further refine a search
CyberPilot™ Pro lets you broaden or narrow the scope of a search. For example, you can 
broaden a search by identifying all files that have at least one of two text strings in their name. 
Conversely, you could narrow a search by looking for all files that were created before a certain 
date and have a particular text string in their notes field.

Search the entire NetCarta WebMap or only what’s currently visible
CyberPilot Pro lets you search through the entire map for the specified criteria, or through only 
the parts of the map that are currently visible. You set up what’s visible by expanding and 
collapsing areas of the WebMap, setting display options, and hiding individual objects.

View information on reported objects or display them in your Web browser
The results of a search are displayed in a results window. Results look similar to a NetCarta 
WebMap, and you can do most of the same things with the results that you can do with a 
WebMap. For example, you can select an object in a results window and display it in your Web 
browser or look at its properties.

Compare WebMaps to keep your maps in sync with a Web site
Keep your own NetCarta WebMaps, and those you’re publishing for others, up-to-date with the 
latest version of a Web site. If the site has changed, you can quickly see everything that’s been 
changed or added since you last visited. If you like, you can then update the new WebMap with 
any customizations you made in the old one.

RELATED TOPICS
Searching made simple
More simple searches
Setting up the Search dialog box
Comparing and updating WebMaps



Searching made simple

CyberPilot Pro lets you search a NetCarta WebMap for particular objects. For example, you may 
want to quickly find an object that has a particular text string in its name. When you perform a 
search, the results appear in a results window. Among other things, you can view information on 
reported objects or display them in your Web browser. 

It’s important to note that whenCyberPilot Pro searches a NetCarta WebMap, it searches through
fields in the map, not through the contents of the Web site objects themselves. 

RELATED TOPICS
To perform a simple text search
To specify advanced search criteria
To get extra mileage from search results



To perform a simple text search

The simplest type of search that you can perform with CyberPilot Pro is to look for objects that 
have a particular text string in one of their WebMap text fields (not in the contents of the object 
itself). Text fields include such things as object labels and properties. The default text search 
locates all HTML pages in the entire map that have a specified text string in any text field. For a 
detailed description of the fields in the Search dialog box, see Setting up the Search dialog box.

To perform a simple text search, do the following:

1. Choose Search from the WebMap menu, or click . The Search dialog box appears.

2. In the Search drop-down list, choose Entire Map.

3. In the Object Type drop-down list, choose All Objects.

4. In the Field drop-down list, choose <all text fields>.

5. In the Modifiers drop-down list, choose Contains, which means that the text string can be 
anywhere in the field.

6. In the Text String box, type the word “NetCarta” (or the text string you want to search for).

7. Select Match Case if you want to search for the text string using the exact capitalization you 
type. 

8. Click Search. All objects that have the specified text string in any of their fields are displayed in
a results window, in this case titled Search Results.

RELATED TOPICS
To get extra mileage from search results
To specify search criteria



To get extra mileage from search results

When you perform a search, the results appear in a results window, in this case called Search 
Results. Each map window can have a single associated results window, which displays either 
the results of a search or the results of a WebMap comparison.

Objects listed in a results window have the same labels as the corresponding objects in the 
NetCarta WebMap. If you change the labels in a results window, the labels will change in the map
window also. For information on object labels, see Changing how objects are labeled.

You can do many of the things in a results window that you can do in a map window: display an 
object in your Web browser, view an object’s properties, and even search the results to further 
refine the list of objects.

To select a reported object in the associated map window, simply select the item in the 
results window. The object is automatically selected in the map window.
To view a reported object in your Web browser, double-click the object.
To view information about a reported object, right-click the item in the results window, and 
choose Properties from the shortcut menu. The Properties dialog box appears. Because the 
dialog box remains onscreen until you close it, you can continue selecting objects in the results 
window and viewing their properties.
To perform a search in a results window, make either the results window or its associated map
window active, and click . In the Search dialog box, choose Current Results from the Search 
drop-down list. Specify the remaining criteria, and click Search.

RELATED TOPICS
Properties dialog box
Comparing and updating WebMaps
To perform a simple text search



More simple searches

CyberPilot Pro lets you search for other things besides text strings. Here are some more simple 
searches that you might want to perform. If you need more help, see Setting up the Search 
dialog box for descriptions of all the search criteria.

Choose from the following list for information about each simple search:

To search for broken links
To search for links between sites
To search for and redisplay individually hidden objects



To search for broken links

A broken link occurs when the object that a link refers to is currently unreachable or has changed
in some way (for example, it’s been renamed, moved, or deleted from the site). A link could also 
be broken because of a typing error in the HTML code itself. CyberPilot Pro lets you search for 
broken links.

To search for broken links to objects, follow these steps:

1. Choose Search from the WebMap menu, or click .

2. Choose Entire Map in the Search drop-down list.
3. Choose Links in the Object Type drop-down list.

4. Choose Broken in the Field drop-down list.
The Modifiers drop-down list automatically displays Equals, and the Value drop-down list 
automatically displays True.

5. Click Search. All broken links appear in the results window. 

RELATED TOPICS
Link icons in search results
To perform a simple text string search
To get extra mileage from search results
To search for links between sites
To search for and redisplay individually hidden objects



To search for links between sites

Any link that points to another Web site is shown in blue in the NetCarta WebMap. CyberPilot Pro
lets you search for these links between sites.

To search for links between sites, do the following:

1. Choose Search from the WebMap menu, or click .

2. Choose Entire Map in the Search drop-down list.
3. Choose Links in the Object Type drop-down list.
4. Choose Between Sites in the Field drop-down list.

The Modifiers drop-down list automatically displays Equals, and the Value drop-down list 
automatically displays True.

5 Click Search. All links that point to different Web sites appear in a results window. 

RELATED TOPICS
Link icons in search results
Setting up the Search Dialog box
To get extra mileage from search results
To perform a simple text search
To search for broken links
To search for and redisplay individually hidden objects



To search for and redisplay individually hidden objects

You can hide objects individually in the NetCarta WebMap by using the Properties dialog box. 
When you select an object in the map and then check Hide All Routes on the Properties dialog 
box, the selected object and its alternate routes are hidden in the WebMap. For details about 
hiding objects, see Showing or hiding individual objects.

When you want to see which objects have been individually hidden, CyberPilot Pro lets you 
search for them. Once located, you can redisplay any hidden object.

To search for individually hidden objects, do the following:

1. Choose Search from the WebMap menu, or click .

2. Choose Entire Map in the Search drop-down list.
3. Choose All Objects in the Object Type drop-down list.
4. Choose Hidden in the Field drop-down list.

The Modifiers drop-down list automatically displays Equals, and the Value drop-down list 
automatically displays True.

5. Click Search. All individually hidden objects are displayed in a results window.

TIP: If you select a hidden object in the results window, the object appears once again in the map
window. The object is selected, but it’s dimmed because it hasn’t been "unhidden" in the 
Properties dialog box. If you then collapse the area of the WebMap containing the dimmed 
object, it will be hidden once again.

To permanently redisplay a hidden object, do the following:

1. Right-click the object in the Search Results window.

2. Choose Properties from the shortcut menu. The Properties dialog box appears.

3. In the Properties dialog box, deselect Hide All Routes. The object reappears in the map 
window.

RELATED TOPICS
To perform a simple text search
Showing or hiding types of objects
Properties dialog box
Setting up the Search Dialog box



Setting up the Search dialog box

To set up the Search dialog box, you specify search criteria as broadly or as narrowly as you 
want. For example, you can search for all objects that match your criteria, or only pages or 
images that do so. You can search for text that occurs anywhere in a text field or that occurs only 
at the beginning of the field. 

Optionally, you can specify advanced search criteria to perform And searches (finds objects that 
meet both the primary and secondary criteria) and Or searches (finds matches that meet at least 
one of the two criteria). 

RELATED TOPICS
To specify search criteria
To specify advanced search criteria
About searching for object versus links
Link icons in search results



To specify search criteria

The Search dialog box has options for specifying exactly what you want to search for. The search
criteria you can specify includes the following:

The part of the map you want to search

The type of objects you want to search for

Which of the fields you want to search through

A search option such as where the text string is in the field or whether a numeric criteria is 
greater than or equal to

A text string, or a numeric or Boolean value.

To specify search criteria, do the following:

1. Choose Search from the WebMap menu, or click . The Search dialog box appears.

2. In the Search drop-down list, choose which part of the map you want to search. The default is 
Entire Map.

3. In the Object type drop-down list, choose which type of objects you want to search through. 
The default is Pages.
Note: The Field drop-down list and the Object Type drop-down list are related in that the 
available Field options are determined by what you choose in the Object Type drop-down list. 
Most of the items in the Field drop-down list correspond to the labels you choose in the Labels 
dialog box.

4. In the Field drop-down list, choose which field you want to search through. 
Note: The available Field options are determined by what is chosen in the Object Type drop-
down list. Many of the items in the Field drop-down list correspond to the labels in the Labels 
dialog box. When the chosen object type is anything but Links, the default field is <all text 
fields>. 

5. In the Modifiers drop-down list, choose which search modifier you want to apply. The chosen 
Field option determines which modifiers are available. When you choose a text field, the 
default modifier is Contains. When you choose a numeric field, the default modifier is Equals.

6. In the Text String/Value text box, specify a keyword or phrase (if you are performing a text 
search) or a numeric value if you are performing a numeric search, or choose True or False. 
The title of this text box alternates between Text String and Value depending on the type of 
search.

7. Click Search. A Search Results window appears, displaying the results of the search.

RELATED TOPICS
To perform a simple text search
To specify advanced search criteria
Search dialog box
Link types and icons
Using link icons for alternate routes





To specify advanced search criteria

The secondary search criteria area of the Search dialog box lets you set up And or Or searches. 
For example, you could narrow a search by looking for all files that were created before a certain 
date and have a particular text string in their notes field (an And search). Conversely, you could 
broaden a search by identifying all files that have at least one of two text strings in their name (an
Or search).

To specify advanced search criteria, do the following:

1. Choose Search from the WebMap menu, or click . The Search dialog box appears.

2. Specify the first set of search criteria.

3. Click Advanced in the Search dialog box. The advanced search criteria area appears.

4. Choose whether you want the two sets of criteria to be related by an And or an Or.

5. Specify the advanced search criteria in the right side of the Search dialog box.

RELATED TOPICS
Setting display options
To perform a simple text search
To specify search criteria
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About searching for objects versus links

For any given object in a Web site—an HTML page for example—there may be multiple 
references (links) to that object, but there is only one object. When you search for a particular 
type of object, CyberPilot Pro finds that one instance of the object. When you search for links, 
CyberPilot Pro finds all references that match the search criteria, everywhere they occur.

As a practical example, you can search for unreachable objects or broken links, both of which 
occur when CyberPilot Pro explores a site and can’t find an object that is being referenced 
somewhere. In a search, if you choose All Objects in the Object type drop-down list and 
Unreachable in the Field drop-down list, CyberPilot Pro will find the actual objects that were 
unreachable, no matter how many references to those objects there may be in the Web site.

On the other hand, if you choose Links in the Object type drop-down list and Broken in the Field 
drop-down list, CyberPilot Pro will find all references (links) that were made to unreachable 
objects.

RELATED TOPICS
To search for broken links
To search for links between sites
To specify search criteria
To specify advanced search criteria
Link icons in search results
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Link icons in search results

When you search for links, they appear in the Search Results window with link icons. Link icons 
function a little differently in the Search Results window than they do in a WebMap. In a 
WebMap, you can choose to display alternate routes (objects that have already been referenced 
elsewhere in the map) with link icons. But when you search for links, all reported items are 
represented by link icons.

In the Search Results window, objects that are main-route objects in the WebMap are 
represented by a hierarchical link icon: 

Objects that are alternate-route objects in the WebMap are represented by the same link icon that you 
would see in the WebMap. For example, this icon represents a link to an object that is at the same level in
the map hierarchy as the object containing the link: 

RELATED TOPICS
Using link icons for alternate routes
To get extra mileage from search results
To search for broken links
To search for links between sites
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Comparing and Updating WebMaps

Busy Web sites tend to change frequently. When using NetCarta WebMaps to help manage an 
evolving site, you’ll want to know that the WebMap you’re using matches the current state of the 
site. CyberPilot Pro lets you compare an old version of a map to a new version of a map. If the 
site has changed, you can transfer customizations from the old map to the new one.

Comparing and updating is particularly useful for comparing a NetCarta WebMap to a changed 
site that has been copied to a CD, to another location in the file system, or from a file system to 
the Web (or vice versa).

RELATED TOPICS
To compare and update WebMaps
To work with comparison results
To get extra mileage from search results
Customizing a NetCarta WebMap



To compare and update WebMaps

CyberPilot Pro lets you compare two versions of a site's WebMap, usually an old one (the source
map) and a new one (the target map). You decide whether or not you want to update the target 
map with the customizations of the source map. 

When you update a WebMap, user-defined notes and names (defined in the Properties dialog 
box), swapped main and alternate routes, and individually hidden object settings are transferred 
from the source map to the target map.

To compare and update WebMaps, do the following:

1. Open the two WebMaps that you want to compare.

2. So that CyberPilotPro will correctly detect all changed objects, use the Explore command  to 
explore both WebMaps to the same level. If you explore individual objects using the question 
mark icon, CyberPilot Pro may not detect changed file-modification dates and, therefore, 
might not accurately report all changed objects.

3. Choose Compare and Update from the WebMap menu, or click . The Compare and Update dialog box
appears.
4. Choose the maps you want to compare in the Source Map and Targe Map drop-down lists. Only open 
WebMaps appear in the lists:

Source Map The map with customizations that you may want to 
preserve, usually the older of the two maps.

Target Map The map that you may want to update with the source 
map's customizations, usually the newer of the two 
maps.

5. If you want to generate comparison reports, select one or both of the options in the Generate 
Reports For area. You can generate comparison results for objects in the source map that 
aren’t found in the target map (orphans) and a report on new and changed objects in the 
target map. (Note that objects with any change, no matter how small, are reported.)

6. If you want to update the target map with the customizations of the source map, select Update 
Annotations from Source Map to Target Map. If you’d like to see the results of the comparison 
before deciding whether or not to update the target map, see Comparing before updating.

7. Click OK. If you selected either of the report options, the appropriate comparison results 
appear: the Orphaned Objects window and/or the Changed Objects window. 

RELATED TOPICS
Narrowing the scope of comparison results
To work with comparison results



Narrowing the scope of comparison results

All orphaned or changed objects are included in the comparison results. If you want to narrow the
contents of the results to certain types of objects—for example, just pages—use the Search 
command  to search the results for the particular object types you’re interested in.

RELATED TOPICS
Comparing before updating
To compare and update WebMaps
To work with comparison results



Comparing before updating

CyberPilot Pro lets you compare two WebMaps first, and then decide whether you want to update
the target map. To do so, simply run the Compare and Update command  twice. In the first run, 
select one or both of the Generate Reports options and deselect Update Annotations from 
Source Map to Target Map.

If, after checking the comparison results, you decide that you do want to update the target map, choose 
Compare and Update  again, deselect the two report options and select Update Annotations from Source
Map to Target Map.

RELATED TOPICS
To compare and update WebMaps
To work with comparison results
Narrowing the scope of comparison results



To work with comparison reports

 When you compare two NetCarta WebMaps, the results appear in one or two results windows, the 
number depending on what you chose to compare. These two results windows are the Changed Objects 
window, which is associated with the source map, and the Orphaned Objects window, which is associated
with the target map. (Each map window can have a single associated results window, displaying either 
the results of a WebMap comparison or the results of a search. If you have multiple map windows open, 
you could have an equal number of results windows.)

Objects listed in a results window have the same label as the corresponding object in the 
NetCarta WebMap. If you change the labels in a results window, the labels will change in the 
associated map window also.

You can do many of the things in a results window that you can do in a map window: display an 
object in your Web browser, view an object’s properties, and even search the results to further 
refine the list of objects. 

RELATED TOPICS
Changing how objects are labeled
Viewing and changing object properties
To get extra mileage from searc results
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Search dialog box

The Search dialog box is accessed from the WebMap menu, or by clicking . You use the Search 
dialog box to search for particular objects, for example, certain kinds of pages or images, and to 
search for links.

The Search dialog box contains drop-down list boxes and text boxes where you can specify the search 
criteria (choices) for customizing your search. The drop-down lists and buttons in the Search dialog box 
are listed here. Choose from this list for a detailed description of each item.

Search
Object Type
Field Type
Modifiers
Text String/Value

RELATED TOPICS
Changing how objects are labeled
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Search drop-down list (Search dialog box)

Use the Search drop-down list to specify what part of the WebMap you want to search. The 
Search choices are described in the following table:

Search options Description

Entire Map Searches the entire WebMap, regardless of what’s 
currently displayed.

Currently Visible Map Searches only those parts of the WebMap that are 
currently displayed.

Current Results Searches the objects contained in the active results 
window (search or WebMap comparison results), or 
the results window associated with the active map 
window.

RELATED TOPICS
Setting up the Search dialog box



Object Type drop-down list (Search dialog box)

Use the Object Type drop-down list to specify whether you want to search for all objects that 
match the criteria or for a particular object type. You can also choose to search for links. The 
Object Type choices are described in the following table:

Object type Description

All Objects All of the items in the list except links.

Pages (default) HTML pages.

Images Graphic images.

Gateways A server-executed program associated with an HTML form.

Internet Services Services such as Mailto, FTP, Gopher, and so on.

Other Audio and video files, PostScript and Java files, NetCarta 
WebMaps, applications, and so on. Unrecognized object 
types are also included.

Links Links such as the ANCHOR tag (A), the IMAGE tag (IMG), 
and so on.

RELATED TOPICS
About searching for objects versus links



Field Type drop-down list (Search dialog box)

Use the Field drop-down list to specify what WebMap field you want CyberPilot Pro to search in.

The available fields are determined by what you choose in the Object Type drop-down list. Many 
of these items correspond to the label options in the Labels dialog box. When you choose 
anything but Links as the Object type, the default is <all text fields>.

Choose from the following list to see the available fields in the Field Type drop-down list 
in the Search dialog box: 

Fields for All Objects
Additional fields for Pages
Additional fields for Images
Additional fields for Gateways
Additional fields for Internet Services
Additional fields for Other
Fields for Links

RELATED TOPICS
Labels dialog box



Fields for All Objects (Search dialog box)

If you choose All Objects as the object type, the following options are available in the Field drop-
down list. These options are also available for the other items in the Object Type list (except for 
links).

Fields Description (searches for)

<all text fields> Objects with the specified string in any text field.

<none> Objects of the specified type. You don’t need to enter 
any other search criteria.

Full URL Objects with the specified text string in their fully-
resolved URL.

Hidden Objects that are not visible because of the Hide All 
Routes option in the Properties dialog box.

Hidden Alternate 
Routes

Alternate routes that are not visible because of the Hide 
All Alternate Routes option in the Properties dialog box. 

Hierarchy Level Objects at the specified level in the WebMap hierarchy. 
The home page is considered level 1, its children are 
level 2, and so on.

HTTP status Objects with the specified return value from the server 
(404, for example, which means the object was not 
found).

Hyperlink Text (on 
main route)

Objects that contain the specified text string in their 
hyperlink text (the text you would click to activate the 
link).

MIME Type Objects of the specified file type, such as video/mpeg or 
image/gif. 

Modification Date Objects with the specified last-modification date. 
(Specify dates using the format set up in your Regional 
Settings control panel.)

Name Objects with the specified text string in their name 
(displayed in the Properties dialog box). If the WebMap 
publisher did not change the name, the default name for 
pages is the HTML TITLE tag text.

Notes Objects with the specified text string in their notes.

Unreachable Objects that couldn’t be reached when CyberPilot Pro 
explored the site. 





Additional fields for Pages (Search dialog box)

If you choose Pages as the object type, the following fields become available in addition to the 
fields listed for All Objects. CyberPilot Pro will search only for pages matching the search criteria.

Field Description (searches for)

Broken Link Count Pages that contain the specified number of broken links.

Headings Pages that contain the specified text string in their 
headings (tagged by H1, H2, H3, and so on).

Load Size Pages that have the specified load size in bytes. Load size 
is the file size of the page itself plus the sizes of all inline 
resources.

Size Pages with a particular size, specified in bytes.

Title Pages that have the specified text string in their HTML 
TITLE tag (the first TITLE tag, in the event a page 
accidentally has more than one).



Additional fields for Images (Search dialog box)

If you choose Images as the object type, the following fields become available in addition to the 
fields listed for All Objects. CyberPilot Pro will search only for images matching the search 
criteria.

Field Type Description (searches for)

Alt String Images that have the specified Alt String, which is an optional 
text string included with the IMG tag (to accommodate people 
who don’t have a graphical browser or who have turned off 
graphics downloading).

Image Map Image maps (images with an ISMAP attribute) that have the 
specified text string in the full URL of their associated gateway.

Inline Image Images that are "embedded" in the displayed HTML (as opposed
to images that are displayed alone).

Size Images of a particular size, specified in bytes.



Additional fields for Gateways (Search dialog box)

If you choose Gateways as the object type, the following fields become available in addition to 
the fields listed for All Objects. CyberPilot Pro will search only for gateways matching the search 
criteria.

Field Type Description (searches for)

Method Gateways that use either the POST or GET. method for handling
input from a form (a special type of HTML home page). POST 
uses standard input. GET puts parameters into environment 
variables.



Additional fields for Internet Services (Search dialog box)

If you choose Internet Services as the object type, no fields become available in addition to the 
fields listed for All Objects. CyberPilot Pro will search only for Internet services that match the 
search criteria.



Additional fields for Other (Search dialog box)

If you choose Other as the object type, no fields become available in addition to the fields listed 
for All Objects. CyberPilot Pro will search only for other ojbects, such as audio files, PostScript 
files, NetCarta WebMaps, and so on, that match the search criteria.



Fields for Links (Search dialog box)

If you choose Links as the object type, only the following fields are available:

Field Type Description

<all text fields> Links with a text field that contains the specified string.

<none> All links. You don’t need to enter any other search criteria.

Between Sites Links that point to an object in another Web site.

Broken Links that point to an object that could not be found during 
exploration.

Hyperlink Text Links with the specified text string in their hyperlink text, 
which is the text you click in the Web page to activate the 
link. 

Link URL Links whose associated URL contains the specified text 
string.



Modifiers drop-down list (Search dialog box)

The Modifiers options are determined by what you choose in the Field drop-down list.

Field Type Search Modifier Description

Text Contains The string is anywhere in the text field. This
is the default.

Starts with The string is at the beginning of the text 
field.

Ends with The string is at the end of the text field.

Matches Exactly The string is the entire text field.

Numeric Equal To The field is equal to the specified value (in 
the Value box). This is the default.

Not Equal To The field is not equal to the specified value.

Greater Than The field is greater than the specified 
value.

Less Than The field is less than the specified value.

Greater Than or 
Equal To

The field is greater than or equal to the 
specified value.

Less Than or Equal 
To

The field is less than or equal to the 
specified value.

Boolean Equals (cannot be 
changed)

The field is equal to the specified value of 
TRUE or FALSE. The default is TRUE.



Text string/value box

In the Text String/Value text box, specify a text string if you’re performing a text search, specify a 
numeric value if you’re performing a numeric search, or choose True or False. The title of this 
box alternates between Text String and Value depending on the type of search.



Customizing a NetCarta WebMap

Customize your WebMaps
You can make Web browsing easier for yourself--and others who might use your WebMaps--by 
customizing your maps. You can collapse or expand the WebMap hierarchy, or hide certain 
pages to put the spotlight on particular areas of a site. 

Customize labels for WebMap objects
Every object in a WebMap is accompanied by a descriptive text label. You can make custom 
labels for individual objects, or choose a different label for each object type. For instance, you 
could draw attention to a particularly interesting page by changing its label to "Great waterfall 
image here!"

Add more information to your WebMap
You can attach notes to any object in your WebMap. If you publish the map, the notes will be 
there to inform people about interesting parts of a Web site (as well as being available for your 
own reference).

Change the navigation route through a site
Most Web sites contain multiple hyperlinks pointing to the same resource. For instance, there are
often several hyperlinks that point to the home page. You decide whether to show only one 
instance of an object in a WebMap--the main route--or all the times the object is pointed to by a 
hyperlink--"alternate routes." You can also swap the main route with an alternate route, to 
emphasize a different way of traveling through a site.

RELATED TOPICS
Beyond pages: Other WebMap objects
Changing how objects are labeled
Showing or hiding types of objects
Showing or hiding individual objects
Viewing and changing object properties
More on alternate routes



Beyond pages: Other WebMap objects

Although you’ll often see only pages in many WebMaps, there are lots of other resources that 
might exist in a Web site. For instance, there could be some GIF images, shown with the Mona 
Lisa icon. 

Or perhaps there’s a fancy new Java applet, or a video file. Every resource in a Web site translates into 
an object type in the WebMap, and it is represented by a unique icon. 
Besides different object icons, you may also see some chain-link icons in the WebMap. 

These represent different hyperlink types. You’ll only see these icons if you’ve changed your display 
option settings so that alternate routes to objects are displayed with these special link icons. 

RELATED TOPICS
WebMap object types
Link types and icons



WebMap object types

The following table shows the object types, with associated icons, that you may see in a 
WebMap. Of course, many of these object types may not exist at all in a particular Web site. Or 
they may exist, but be currently hidden. (In new WebMaps, only pages and embedded NetCarta 
WebMaps are shown by default.) You can change that with the Display Options dialog box. And 
you can change how object types are labeled with the Labels dialog box.

Icon Description

HTML page

HTML page w/ form

Page with Netscape Navigator 2.0 frame

NetCarta WebMap

Mailto 

Image

Audio

Video

Gateway 

Java applet

Application

PDF file

Microsoft Word file

PostScript file

Text

FTP

Gopher

WAIS

NNTP



Telnet

Generic Internet Service

Unknown object type. 

RELATED TOPICS
Link types and icons



Using link icons for alternate routes

CyberPilot Pro lets you decide how to portray a Web site: as a collection of objects, or as the 
relationships between the objects. It’s all in how you look at it. There may be times when you’ll 
prefer to focus on WebMap relationships, and others when you’ll be more interested in the types 
of objects in the map.

If you like, you can depict alternate routes to objects with link icons. You might want to do this 
when you’re interested in looking more closely at the relationships between Web objects; that is, 
you want to focus on the hyperlinks between objects, rather than the objects themselves.

So, you can choose to display alternate routes as the object they point to; for example, this icon 
for images: 

When you show alternate routes with object icons, you get a better look at exactly which resources are 
available in the site, as well as the context in which they’re pointed to. For instance, if there is more than 
one hyperlink pointing to one particular image, you can see at a glance what pages contain those 
hyperlinks, and thus get an idea of why it’s referred to so often.

Alternatively, you can choose to portray alternate routes as a link type that represents the 
relationship between objects. For example, this link points to an object higher in the hierarchy 
than the page the hyperlink resides on:

RELATED TOPICS
Link types and icons
More on alternate routes
To show or hide all alternate routes



To display alternate routes with link icons

To display alternate routes with link icons, do the following:

1. Choose Display Options from the View menu, or click . The Display Options dialog box 
appears.

2. Select Display[Alternate Routes] As Link Icons, and click OK. For information on setting the other 
options in the Display Options dialog box, see Showing or hiding types of objects.

RELATED TOPICS
Display Options dialog box
Using link icons for alternate routes
Link types and icons
More on alternate routes
To show or hide all alternate routes



Link types and icons

Link icons let you quickly see where a hyperlink points in the map hierarchy: within the same 
page, higher in the hierarchy, lower in the hierarchy, or the same level in the hierarchy. 

Note that only alternate   routes   can be displayed with link icons. Main route objects are always 
depicted with their object icons. For instance, the main route to an image will always show the 
Mona Lisa icon. Remember, too, that you can choose to display alternate routes with object icons
instead of the link icons shown in the following table. 

Link type Icon Label
Color

Description

Higher in 
hierarchy

Green Points to an object higher in the map 
hierarchy than the page on which the link 
resides.

Lower in 
hierarchy

Green Points to an object lower in the map 
hierarchy than the page on which the link 
resides.

Same level in
hierarchy

Green Points to an object at the same level in the 
hierarchy as the page on which the link 
resides.

Within page Green Points to an object on the same page.

Offsite Blue Points to an object in a different Web site.

Search 
Results

Black Appears in Search Results window 
when a main-route hyperlink is found.

Broken None Red Points to an unreachable object.

RELATED TOPICS
More on alternate routes
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Link types and icons



To show or hide all alternate routes
Exploring further: Building a NetCarta WebMap
WebMap object types
Changing how objects are labeled
Showing or hiding types of objects



Changing how objects are labeled

You can change the descriptive labels for any object in the WebMap. For instance, in all new 
WebMaps, pages are labeled with their Name field (by default, the HTML TITLE tag). If you 
wanted to see the full URL instead, you could change the label with the Labels dialog box. Any 
changes you make to labels will appear in the WebMap itself, as well as in the Properties window
and results window.

Depending on which object type you’ve selected, different labels are available. See Object types 
in the Labels dialog box for details. 

RELATED TOPICS
To change the label for an object type
To change the label for a particular object
To change the name of an object
Labels available for all object types
What the label colors mean
WebMap object types



To change the label for an object type

You can change the descriptive labels for any object type in the WebMap. 

To change how object types are labeled in the WebMap, the Properties dialog box, and the
results window, do the following:

1. Choose Labels from the View menu, or click . The Labels dialog box appears.

2. If you want to use the same labels for all object types, select the Apply to All Object Types 
checkbox. If you want to use different labels for each object type, select an object type from 
the list. The labels available for that type are shown in a drop-down list.

3. Choose a First Choice for the label; this will be the default for the selected object type. 

4. You can select an alternate choice for the label (if your first choice for the display label is not 
available for a particular object). For example, some images might not have an ALT string, 
which is descriptive text the Webmaster can include with the image. So for images, you might 
want to specify ALT string as the First Choice, and Hyperlink text as the alternate choice. If 
you don’t specify an alternate choice, and the first choice isn’t available for an object, the Link
URL will be used as the label.

5. Click Apply to see how your label choices are affecting the map window. You can keep 
adjusting the labels until you’re happy with them.

6. If you want to save your label settings as the default to be used with all new maps (existing 
maps use the label settings you set for them), click Save As Default. Anytime you want to use 
these label settings on an existing map, choose Load Default.

7. When you’re ready to accept the changes you’ve made, click OK.

Note that if neither your first nor alternate choices are available for a particular object, the object 
will be automatically labeled with the Link URL.

RELATED TOPICS
Labels available for all object types 
To change the label for a particular object
To change the name of an object
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WebMap object types



To change the label for a particular object

The Labels dialog box lets you change the label for any object type. But if you want to change the
label for one particular object, you’ll need to use the Properties dialog box. 

For example, in your WebMap, you might like to draw attention to a few pages by giving them 
attention-grabbing labels. Here’s how:

1. In the WebMap, right-click the page you want to make a new label for.

2. From the shortcut menu, choose Properties. The Properties dialog box appears.

3. In the Name field, type whatever you like. Click OK.

4. If it isn’t already, make Name the First Choice for page labels. (See To change the label for an 
object type if you don’t know how to do this.)

5. Repeat these steps for each page whose label you want to change.

If you change the name of a page and decide you want page labels to revert back to TITLE, go 
back to the Labels dialog box and choose Title for the First Choice for pages.

RELATED TOPICS
Labels available for all object types 
To change the label for an object type
What the label colors mean
WebMap object types
Labels dialog box
Viewing and changing object properties



Object types in the Labels dialog box

The available object types are shown in the following table, along with the default label settings 
that come with CyberPilot Pro. (If you’re using a WebMap published by someone else, the 
defaults may have been changed by the WebMap publisher.) Note that not all MIME types are 
available as a separate choice, but are part of a larger object-type category. 

If you want to change the label for an individual object--such as a particular audio file--see To 
change the label for a particular object.

Object Type Included MIME Types Default First 
Choice Label

Default Alternate 
Choice Label

Pages HTML pages, HTML pages 
with data-entry form

Name TITLE by 
default)

Hyperlink Text

Images GIF, JPEG, BMP, and other 
types of images

ALT String Link URL

Gateways CGI script files, which may 
be written in C, PERL, or 
some other programming 
language

Hyperlink Text Link URL

Internet 
Services

FTP, telnet, mailto, WAIS, 
NNTP, gopher, and all other 
Internet services.

Hyperlink Text Link URL

Other All other object types and 
applications that aren’t 
included in other object 
categories, including 
NetCarta WebMaps, audio 
and video files, text files, 
PostScript, Java applets and 
other applications, and 
<glossary>PDF files.

Hyperlink Text Link URL

Alternate 
routes

All secondary occurrences of
objects in the WebMap 
(green labels).

Hyperlink Text Corresponding 
Object Label
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Labels available for all object types

Depending on which object type you’ve selected, different labels are available. Choose from this 
list for information on the different labels that are available:

Labels available for alternate routes
Additional labels for HTML pages
Additional labels for images
Additional labels for gateways

The following labels are available for all object types:

Label types Description

Name For pages, this is the HTML TITLE text by default. (There is no 
default for other object types.) If you prefer, you can enter 
anything you want in an individual object’s Name field (in the 
Properties dialog box) so that your labels are customized to your
liking.

Full URL Full URL, with protocol, domain, directory, and file name.

Full Path The complete directory path and file name for the object.

Link URL The URL associated with the link on the object’s parent page. 
The Link URL can be absolute (the full Internet address) or 
relative (the path name relative to the site’s home page 
directory).

Hyperlink Text The text (if any) used in the hyperlink reference on the 
object’s parent page.

ModificationDate The date the object was last changed, if known. (Some servers 
may not return this information.)

MIME Type The object’s specific MIME type. For example, a GIF image 
would be labeled image/gif.

RELATED TOPICS
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Labels available for alternate routes

Alternate routes have three label choices available:

Label Type Description

Hyperlink Text The text (if any) used in the hyperlink reference on 
the parent page.

Link URL The URL associated with the link on the object’s 
parent page. The Link URL can be absolute (the full 
Internet address) or relative (the path name relative 
to the site’s home page directory).

Corresponding Object 
Label

The same label that was chosen for the object type on the 
main route. For example, if the link points to an image and 
you’ve chosen size as the label for images, any alternate 
routes to images will also be labeled with the size.

RELATED TOPICS
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Additional labels for HTML pages

In addition to the label choices available for all objects, you can choose one of the following 
labels for HTML pages:

Label Type Description

Title The text string in the HTML TITLE tag. (By default, the Name 
label choice is the same as the Title for HTML pages.)

First Heading The text in the first HTML heading (H1, H2, H3...) found on the 
page.

 Size The size of the HTML page itself, not including any 
external inline objects (such as images).

Load Size The full loading size (when loaded by a Web browser) of the 
page, including inline images, audio and video files, and so on.

RELATED TOPICS
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Additional labels for images

In addition to the label choices available for all objects, you can choose one other label for 
images:

Label Type Description

ALT String The optional text string included with the HTML IMG tag 
(to accommodate people who have a non-graphical 
browser or who have turned off graphics downloading).

RELATED TOPICS
Object types in the Labels dialog box
Labels available for all object types
To change the label for an object type
To change the label for a particular object
What the label colors mean
WebMap object types
Labels dialog box



Additional labels for gateways

In addition to the label choices available for all objects, you can choose one other label for 
gateways:

Label Type Description

Method POST or GET. This is the method by which data 
entered in a form is passed to the CGI script for 
processing. If you don’t know what POST or GET 
mean, don’t worry--you don’t need to know, unless 
you’re a database programmer and therefore have 
reason to use this label choice. (For more information 
about POST and GET, refer to an HTML reference 
manual.)

RELATED TOPICS
Object types in the Labels dialog box
Labels available for all object types
To change the label for an object type
To change the label for a particular object
What the label colors mean
WebMap object types
Labels dialog box



Showing or hiding types of objects

Although it’s sometimes useful to see all Web site resources in your WebMap, you’ll often want 
to reduce clutter and conceal objects that are not particularly useful to you. For example, you 
might not want to see any images at all in your WebMap. Or you might want to hide all alternate 
routes, so that each object is shown once and only once in the WebMap.

You use the Display Options dialog box to determine which object types you want to view while 
using CyberPilot Pro. To hide an individual object (such as one particular image), see Showing or
hiding individual objects.

When you save a WebMap, any display options you’ve changed are saved with the map. The 
next time you open the WebMap, any hidden objects will still be be hidden, but you can see them
again by changing the display options.

If you want to customize your WebMap to share with other people, you can permanently hide 
certain types of objects in the WebMap using publish options, and then publish the map so that 
any hidden objects are actually removed from the WebMap; they can’t be retrieved. However, 
any objects you’ve hidden only with the Display Options dialog box will still be available in the 
published map. For more information about publishing options, see Publishing NetCarta 
WebMaps.

RELATED TOPICS
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Display Options default settings
Object types in the Display Options dialog box
To show or hide object types
To show or hide all alternate routes



Display Options dialog box 

Choose Display Options from the View menu, or click  to see the Display Options dialog box, 
which contains the options shown in the following table:

Option Name Description

Show All Objects Shows all objects in the WebMap. When you select 
this checkbox, all listed objects are dimmed, indicating
they will all be shown in the WebMap.

Show Only Shows the objects you choose in the WebMap. 
Available only when Show All Objects is deselected.

Select All Selects all the objects. 

Clear All Deselects all the objects.

Show Alternate Routes Shows alternate routes to objects. 

Within Page Shows alternate routes that are on the same page.

Allow Expansion Allows alternate routes to be expanded.

Display As Displays alternate routes with either object icons (the 
default) or link icons. 

Load Default Loads the default display options.

Save As Default Saves the current display options as the default. Note:
If you change the default settings and save them, you 
override the settings that come withCyberPilot Pro. To 
return to the original settings, set them manually and 
click Save As Default.

Display Options default settings

CyberPilot Pro comes with these default display options. If you’re using a WebMap published by 
someone else, the default display options may have been changed by the WebMap publisher. 

Note that pages are always shown in a WebMap. You can’t hide them, since do so would mean 
that nothing would be visible in the WebMap, including the home page.

Display Option Default Setting

Show All Objects Deselected

WebMaps Selected



Show Alternate Routes Deselected

Allow Expansion Selected

Display [Alternate Routes] As 
Objects

Selected

RELATED TOPICS
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To change the default display options

CyberPilot Pro comes with default display options. You can change these settings for the current 
map and then save your changes as the default for new maps. (Existing maps retain the settings 
you’ve created for them. If you want to use default settings on an existing map, click Load 
Default.)

To change the default display options, do the following:

1. Choose Display Options from the View menu, or click .

2. Change the settings as you like.
3. Click Save As Default to save your new defaults for the current WebMap and for all new maps 

you create. Click OK.

Note: When you change the default settings and save them, you override the default settings that
come with CyberPilot Pro. You cannot recover the original default settings, unless you enter them
manually and then click Save As Default.

RELATED TOPICS
To load default settings
Display Options dialog box



To load default settings

You can load the default display options into any WebMap by clicking Load Default. (New maps 
automatically use the default settings.) If you haven’t changed the default settings, you can use 
Load Default to use the settings that came with CyberPilot Pro.

To load your default settings, do the following:

1. Choose Display Options from the View menu, or click .

2. Click Load Default.

RELATED TOPICS
To change the default display options
Display Options dialog box



Object types in the Display Options dialog box

You can choose to show only certain object types by selecting them from the Show Only list in 
the Display Options dialog box. Not all the MIME types you see in a WebMap are listed in the 
Show Only list, but may be included in a more general category. For example, the gopher object 
type is a subtype of the Internet Services type in the Show Only list.

Note that pages are always displayed in a WebMap. You cannot hide them, since to do so would 
mean that nothing would be visible in the WebMap, including the home page.

Object 
Type

Included MIME Types Default 
Setting

Pages HTML pages, HTML pages with 
data-entry form

Shown. 

WebMaps NetCarta WebMaps Shown

Applications Java applets, EXE files, PDF files, 
Microsoft Word documents, and 
other applications

Hidden

Audio WAV, AIFF, AU, and other audio 
files

Hidden

Gateways CGI script files, which may be 
written in C, PERL, or some other 
programming language

Hidden

Images GIF, JPEG, BMP, and other types of
images

Hidden

Internet 
Services

FTP, telnet, mailto, WAIS, NNTP, 
gopher, and all other Internet 
services

Hidden

Text Text files (other than HTML pages), 
including plain text and PostScript 
files

Hidden

Unrecognized Any object that CyberPilot Pro can’t
identify

Hidden

Video MPEG and other video file types Hidden

RELATED TOPICS
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Showing or hiding individual objects



To show or hide object types

You use the Display Options dialog box to show and hide objects. The Show Only list shows all 
the object types that can be present in a WebMap. Of course, not all Web sites contain all object 
types, so some of the checkboxes may be irrelevant to the WebMap you’re working with right 
now. For a list of the object types, see Object types in the Display Options dialog box. 

To show or hide objects, do the following:

1. Choose Display Options from the View menu, or click . 

2. If you want to show all objects, select the Show All Objects checkbox. All other checkboxes 
under Show Only will be dimmed and not selectable.

3. If you want to show only particular object types, select the object types you want to show in the
Show Only list. 

4. If you want to show most (but not all) object types, click Select All and then deselect the one or
two object types you don’t want to show. If you want to show just a few object types, choose 
Clear All and select the object types you want to show. If you later choose Show All Objects, 
your checkbox settings will be dimmed but will remain as you set them.

5. When you’re satisfied with your settings, click OK.

If you want to hide individual objects, see Showing or hiding individual objects.

RELATED TOPICS
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To show or hide all alternate routes

When the Show Alternate Routes checkbox (in the Display Options dialog box) is deselected, 
only the main route to an object appears in the map window. This can be useful when you want to
navigate around a site, but you may want to view alternate routes if you’re interested in seeing 
the different ways a site is connected by hyperlinks. If you select this checkbox, the alternate 
routes can be expandable, and you can show them as either object or link icons.

To show alternate routes to an object, do the following:

1. Choose Display Options from the View menu, or click .

2. Select Show Alternate Routes.
3. If you want to show alternate routes within the same page, select the Within Page checkbox.

4. If you want to see alternate routes represented as link icons in the map window, select Link 
Icons under the Display As area.

5. If you want alternate routes to be expandable, select the Allow Expansion checkbox.

6. Click OK.

Note: You can hide alternate routes to a particular object using the Properties dialog box.

RELATED TOPICS
More on alternate routes
Using link icons for alternate routes
To allow or disable expansion of alternate routes
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Showing or hiding individual objects
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To show or hide object types



Showing or hiding individual objects

You can customize a NetCarta WebMap by hiding individual objects. This is particularly useful 
when you are preparing to publish a map for use by others; individually hidden objects are not 
saved with published maps. You can choose to hide all routes to an object in the WebMap--the 
main route, and all alternate routes. Or you can hide only the alternate routes to an object, so 
that only the main route is showing.

Note: You cannot hide just one alternate route to an object; you must hide all or none of them. 

If you’ve hidden an object, you can locate and redisplay it. See To locate and redisplay 
individually hidden objects.

RELATED TOPICS
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To hide all routes to an object

You can hide the main route to one particular object, as well as all alternate routes, even if you’ve
included all objects of its type. For instance, in the Display Options dialog box, you may have 
specified that images should be shown, but you can hide a particular GIF image (for example, a 
frequently used navigation icon) by checking the Hide All Routes checkbox in the Properties 
dialog box (when that image is selected in the map window). 

To hide all routes to an object, do the following:

1. Right-click the object you want to hide from view. You can select either the main route or any 
alternate route to the object.

2. Choose Properties from the shortcut menu. The Properties dialog box appears.

3. Select Hide All Routes, and click OK. 

Shortcut: In the WebMap, select the object you want to hide and press Ctrl+H.

RELATED TOPICS
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To hide all alternate routes to an object

You may have used the Display Options dialog box to specify that all alternate routes should be 
included, but you can hide alternate routes to a particular object. For example, you might want to 
exclude all alternate routes to the home page to avoid clutter in the WebMap. Note that you 
cannot hide one specific alternate route to a particular object; you can only hide all alternate 
routes to the object.

To hide all alternate routes to an object, do the following:

1. Right-click the object for which you want to hide alternate routes. You can select either the 
main route or an alternate route to the object.

2. Choose Properties from the shortcut menu. The Properties dialog box appears.

3. Select Hide All Alternate Routes, and click OK. The main route to the object will appear in the 
map window, but all alternate routes will be hidden.

Note: Any objects you’ve hidden using the Properties dialog box will not be shown in the map 
window. However, you can easily locate hidden objects (see To locate and redisplay individually 
hidden objects).

RELATED TOPICS
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To locate and redisplay individually hidden objects

If you hide individual objects in a WebMap, you may eventually want to find or redisplay one or 
more of them. You can search for individually hidden objects using the Search dialog box.

To locate and redisplay individually hidden objects, do the following:

1. Choose Search from the WebMap menu, or click . The Search dialog box appears.

2. Set up the rest of the dialog box to define where and how you want to search. For example, to search 
for hidden images, select Images in the Object Type drop-down list. (See To specify search criteria.)

3. Choose Hidden from the Field drop-down list. 

4. Click Search. A Search Results window appears, listing all individually hidden objects that 
meet your search criteria.

5. To redisplay a hidden object, select it in the Search Results window. The object appears—
dimmed and selected—in the map window.

6. To "un-hide" a hidden object so that it shows up in the WebMap again, right-click it and choose
Properties. 

7. Deselect Hide All Routes or Hide All Alternate Routes, and click OK.

RELATED TOPICS
Properties dialog box
To hide all routes to an object
To hide all alternate routes to an object
Showing or hiding types of objects
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Viewing and changing object properties

You can view an object’s properties with the Properties dialog box Properties dialog box.

To view properties, do the following:

1. Select an object in the WebMap.

2. Choose Properties from the Object menu, or click . Alternatively, choose Properties from the 
right-click menu.

Each object you select in the WebMap has properties associated with it: the full URL, name of 
the object, and a notes section where you can enter annotations about the object. There is also 
information about the object’s MIME type, service type, whether the object has been explored, 
and if it was successfully reached when CyberPilot Pro made the map. You can also hide an 
object individually or hide alternate routes to the selected object using this dialog box.

RELATED TOPICS
WebMap object types



To display the Properties dialog box

The Properties dialog box contains the properties of the object that you’ve selected in the 
WebMap. You can keep this dialog box open at all times on your screen. As you click different 
objects, you’ll see the properties change.

There are three ways to display the Properties dialog box:
 Click the Properties icon on the Toolbar.

Right-click the object whose properties you want to view and choose Properties from the shortcut menu.

Choose Properties from the Object menu.

Field Description

Full URL The full URL (Uniform Resource Locator) or Internet 
address for an object, including the protocol and domain 
name. For example, http://www.netcarta.com.

Name By default, this is the HTML TITLE tag for pages. (There is 
no default for other objects.) You can change the Name to 
anything you like.

Notes You can enter notes about any object. If you’ve entered no 
other notes, the hyperlink text appears in the Notes field.

Hide All Routes 
and Hide All 
Alternate Routes

These checkboxes let you hide all routes to an object or 
just the alternate routes. For example, you might have a 
customized WebMap that shows all images, but decide 
you want to hide a particular GIF. You can choose Hide All 
Routes, and all instances of that GIF object will be hidden.

Service Type The application protocol, such as http, ftp, mail, news, 
gopher, wais, unknown. 

MIME Type The major and minor MIME types, for example, image/gif.

Status Indicates if the object is explored or unexplored. If an 
object was unreachable, there is also a code number and 
description explaining why it was unreachable.

RELATED TOPICS
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To determine why an object was unreachable

In the bottom part of the Properties dialog box, there is status information about the selected 
object next to the word "Status." You’ll either see "Explored" or "Unexplored," indicating whether 
or not CyberPilot Pro has fully explored the object. 

If the object was unreachable--that is, if its label is red in the WebMap--you’ll also see a number 
and message about why the object was unreachable.

To see why an object is unreachable, do the following:

1. Right-click an object with a red label, then choose Properties.

2. Look at the information under "Status" at the bottom of the dialog box. 

3. If you see status codes 403 or 404, the object is truly unreachable; you probably won’t 
succeed in reaching it if you try again.

4. If you see a status code of 500, you might want to try reaching the object again. Try double-
clicking the icon or label at a later time.

The status code numbers and messages are described in the following table: 

Status 
#

Message Description

403 Forbidden The object was found on the server, but 
CyberPilot Pro’s request to access the object 
was denied. Usually this is because you need a 
password or some other security code to gain 
access to the site or the specific object. Unless 
you do have the password for the resource, you 
probably won’t be able to reach this object if 
you try again.

404 Not Found This represents a truly "broken" link. The page 
or other resource either isn’t on the server, or it 
exists at a different URL than is specified in the 
Link URL on the object’s parent page. Until and 
unless the site’s Webmaster fixes the broken 
link, you won’t have any success in trying to 
reach this object again.

500 Internal Server Error When CyberPilot Pro tried to locate the page or 
other object, it was unable to establish 
communication with the server. The server was 
down or having other technical difficulties, or 
there was some problem with Internet traffic or 
connections. In this case, you may want try to 
reach the object again later, since such 
technical problems are often temporary. 

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
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To change the name of an object

You may want to add more information to your WebMap by creating your own descriptive labels 
for individual objects. You do this by editing the Name field in the Properties dialog box:

To change the name of an object, do the following:

1. Select the object you want to rename in the WebMap.

2. Click , or right-click the object and choose Properties from the shortcut menu.

3. In the Name field, enter anything you want. For instance, for an image of a horserace, you might type 
"Bold Lightning’s last race." Click Apply.

4. You’ll now need to change the label for images to Name, using the Labels dialog box.

RELATED TOPICS
To change the label for a particular object
Labels available for all objects
Labels dialog box
Properties dialog box



To create and view notes

You can add notes to a specific page or other object. Notes let you give people additional 
information about pages and other objects. You can view the notes yourself, and they are also 
included if you publish your WebMap. People who use your published map can view the notes (in
the Properties dialog box) to see if they’re interested in browsing a particular object.

To create and view notes for an object, do the following:

1. Select an object in the WebMap.

2. Click , or right-click the object and choose Properties from the shortcut menu.

3. View existing notes, or enter anything you want in the Notes area of the dialog box. Notes can be as 
long as you like.

4. Click OK.

RELATED TOPICS
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More on alternate routes

The more deeply you probe into WebMaps, the more you’ll want to know about alternate routes. 
Understanding alternate routes--and then deciding whether or not to display them--can be a key 
part of the customization process. This section takes a closer look at alternate routes and some 
of the things you can do with them.

Take the main highway...
When CyberPilot Pro explores a site, the first time a hyperlink to a particular page or other object 
is found, the object is displayed with a black label in the WebMap (or blue if it’s an object on 
another site). This is the main route to the object. No matter how it’s built, the WebMap hierarchy 
depicts one and only one main route.

Typically, when you’re browsing a site with your Web browser, the main route is the most direct 
route, because each object is reached the first time via the shortest number of hyperlinks from 
the site’s home page. For example, a hyperlink on the home page that points to a particular GIF 
image is the main route to that image. If that same GIF is pointed to by a hyperlink on another 
page deeper in the site, it’s not the shortest route to that object. 

When CyberPilot Pro builds a WebMap automatically (via the Explore command), it reflects this 
typical way of browsing a Web site: hierarchically, beginning with the site’s home page, then the 
hyperlinks on the home page, then the hyperlinks on those pages, and so on and on, working 
down through the site a level at a time.

...Or the scenic route
But the hierarchical view you see in the map window is just one way of representing a Web site. 
In fact, a Web site is just that: it’s a web of objects, not a linear hierarchy. When you’re surfing 
the Web, there are often hyperlinks in many places in the site that allow you to jump to the same 
page. Our term for these multiple jumping-off places is alternate routes, and they’re displayed in 
green in the WebMap. So, the second time (and all subsequent times) that CyberPilot Pro 
discovers an object via a hyperlink, it displays it in green. 

To sum up: CyberPilot Pro represents each linked object only once in black. If an object is 
referenced again by a hyperlink, it appears in green. Since there’s no limit on how many 
hyperlinks point to the same object, there may be many alternate routes to the same object.

RELATED TOPICS
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To change the main route to an object

Since a Web site is a web of resources, not an orderly hierarchy, you may want to reorganize the 
layout of your WebMap so that a particular alternate route becomes the main route. This is 
particularly useful if you’re publishing your WebMap for others to use and want to emphasize a 
different navigation route through the site.

The only restriction on swapping routes is that you can't designate an alternate route that is in the
same "branch" of the hierarchy as the current main route.

To change the main route to an alternate route, do the following:

1. Select the alternate route you want to swap.

2. Click the right mouse button, or choose the Object menu.

3. Choose Make Main Route.

The main route and alternate route will swap positions. Any children of the two instances will 
move with their parent object, so that the hierarchy is rearranged.

RELATED TOPICS
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To allow or disable expansion of alternate routes

By default, objects that are on the main route and alternate routes are expandable. You can click 
the plus  and minus 

 icons to view the same part of the hierarchy from multiple locations in the map, rather than having to 
keep track of where the main route is. 
Sometimes you may find it more convenient to allow expansion of only the main route; this keeps your 
WebMap more compact, and prevents you from going around in circles (by expanding the hierarchy 
under the same object multiple times).

On the other hand, you may want to allow expansion of alternate routes if you like to use the 
WebMap in much the same way as you browse: following hyperlinks around the site as the mood
strikes you, which sometimes involves clicking the same link more than once.

To make only the main route expandable, do the following: 

1. Choose Display Options from the View menu, or click .

2. Deselect Allow Expansion.
3. Click OK. Any pages shown in green that have "child" objects (that is, the page contains 

hyperlinks) will no longer have a plus or minus icon next to them. 

Alternate routes can only be expanded one at a time, by clicking individual plus icons. To save 
time, the Expand and Expand From Here commands don’t expand alternate routes, since it could
take a long time to expand multiple instances of the same object.

RELATED TOPICS
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{button M,JI(`PILOTPRO.HLP',`M')}{button N-O,JI(`PILOTPRO.HLP',`N_O')}{button P-
Q,JI(`PILOTPRO.HLP',`P_Q')}{button R-S,JI(`PILOTPRO.HLP',`R_S')}{button T-
U,JI(`PILOTPRO.HLP',`T_U')}{button V-W,JI(`PILOTPRO.HLP',`V_W')}{button X-
Z,JI(`PILOTPRO.HLP',`X_Z')}

A
ALT string (for images)
alternate route
application

B - C
between-site object
broken hyperlink
broken link
CGI (Common Gateway Interface) script
child
collapse
corresponding object label
crawler

D - E
default.wmp
domain name
expand
explore

F
frame
FTP (File Transfer Protocol)
full path
Full URL

G
gateway
gopher



H
heading
helper application
hierarchy
home page
HTML (Hypertext Markup Language)
HTTP (Hypertext Transfer Protocol)
hyperlink
hyperlink text

I
imagemap
inline
Internet service
IP address
ISMAP

J - L
Java™
label
link
Link URL

M
mailto
main route
map window
meta-WebMap
MIME type

N - O
Name field
NetCarta WebMap™
NetCarta WebMap™ publisher
NNTP (Network News Transfer Protocol)
Notes
object
offsite object
onsite object

P - Q
page



parent page
PDF (Portable Document Format) file
PostScript™ file
Properties dialog box
protocol
published WebMap

R - S
robot
robot exlusion protocol
root directory

T - U
telnet
TITLE
unexplored object
unreachable object
URL (Uniform Resource Locator)
Usenet news

V - W
WAIS (Wide Area Information Server)
.WMP file
WebMaster

X-Z



ALT string (for images)

An optional text string that a Webmaster may include with an HTML IMG tag, used to describe 
the associated image. For example, for an image of a waterfall, the ALT string might read: "GIF 
image of waterfall." The ALT string allows people who use text-only browsers, or who have 
chosen not to download images, to know what the image depicts.



alternate route

A secondary occurrence of a page or other object in a NetCarta WebMap™, shown with a green 
label. When you see an alternate route to an object, it means the object is pointed to by more 
than one hyperlink.



application

In a NetCarta WebMap™, Java™ applets, EXE files, PDF files, Microsoft™ Word documents, 
and other applications.



between-site object

An object that is on a different site than its parent page. Between-site objects have blue labels.



broken hyperlink

A hyperlink URL that CyberPilot™ Pro cannot locate, because the URL is not valid, the object the
hyperlink points to doesn't exist, or the server containing the object is busy or having other 
technical difficulties.



broken link

A link URL that CyberPilot™ Pro cannot locate, because the URL is not valid, the object the link 
points to doesn’t exist, or the server containing the object is busy or having other technical 
difficulties.



CGI (Common Gateway Interface) script

A program that allows a server to communicate with users on the Internet. For example, when 
you enter information in a form on a Web page, a CGI script interprets the information you enter 
and communicates it to a database program on the server.



child

An object that appears below the selected object in the WebMap hierarchy. For example, any 
objects pointed to by hyperlinks on the home page are represented in the NetCarta WebMap™ 
as "children" of the home page.



collapse

To hide from view all children of the selected object, either by clicking the minus control icon, or 
by using the Expand command.



corresponding object label

Label choice for alternate routes to an object that uses the same label as for the main route to 
the same object.



crawler

A fast, automated program—such as a search engine, indexing program, or cataloging software
—that requests Web pages much faster than human browsers can. When CyberPilot™ Pro 
automatically explores a Web site, it    operates as a crawler. Other commonly-used terms for 
crawler include "robot" and "spider."



default.wmp

A NetCarta WebMap™ of a site, placed in the site’s root directory by the Webmaster. When you 
first attempt to create a WebMap with the New Map command, CyberPilot™ Pro checks to see if 
there is already a default.wmp file on the site.



domain name

A text representation of an object's IP address, using the unique name of the server computer, 
plus the kind of operation it's involved in—such as .com for a business or .edu for an academic 
institution. Domain names may have several parts, separated by periods. For example, 
www.netcarta.com is the domain name for the NetCarta site, where www.netcarta is the unique 
name for NetCarta's server on the World Wide Web, and com is the type of activity the company 
is involved with (in this case, a commercial business).



expand

To show all immediate children of the selected object, either by clicking the plus icon, or by using 
the Expand command.



explore

To look up the URL of an object. If the object is a page that contains links to other objects, 
exploring the page also looks up the URLs for those linked objects. CyberPilot™ Pro explores an 
object when you click its question mark icon, or when you use the Explore command.



frame

Netscape Navigator 2.0 extension to HTML that allows Webmasters to subdivide a site into two 
or more windows. Frames can be linked to another URL. Commonly, frames are used to create a 
non-scrolling area of the screen, such as a company banner that stays onscreen at all times, or 
for navigation buttons that work only within the site.



FTP ( File Transfer Protocol)

A protocol used for transferring files across the Internet. FTP is often used for anonymous 
downloading of text files, software, audio or video files, and other information.



full path

The directory and file name for an object, including the root directory.



Full URL

The complete Internet address for an object, including the protocol and domain name. For 
example, the Full URL for NetCarta's site is http://www.netcarta.com. The Full URL can be used 
as a label for WebMap objects. 



gateway

In a WebMap, a representation of a CGI script.



gopher

A menu-driven, browseable index of servers, sites, directories, and file information available on 
the Internet.



heading

On an HTML page, text that has been formatted with one of several header tags: H1, H2, H3, 
and so on. You can use the first heading encountered on HTML pages as a label for pages.



helper application

An application that can be used in conjunction with your browser to view or access WebMap 
objects. For example, an audio player is a helper application for listening to certain audio files. 
CyberPilot™ Pro is your browser’s helper application for viewing NetCarta WebMaps™.



hierarchy

The relationship between objects in the map window, determined by the links between the 
objects. CyberPilot™ Pro creates the hierarchy by first looking up the URL for the home page, 
then the links on that page. Objects pointed to by links are shown as children of the home page. 



home page

The page from which you want to begin mapping a Web site. This could be the home page for 
the site, or any other page in the site.



HTML (Hypertext Markup Language)

A formatting language for documents (pages) on the World Wide Web. HTML files are plain text 
files with formatting codes that tell Web browsers how to display text, graphics, and hyperlinks.



HTTP (Hypertext Transfer Protocol)

The protocol used to transfer Web pages and other objects between computers and servers on 
the World Wide Web.



hyperlink

The "clickable" area on a Web page that allows you to jump from one Web object to another. 
Hyperlinks are created by an HTML code called HREF.



hyperlink text

The text string associated with a hyperlink on an object's parent page. In CyberPilot™ Pro, you 
can use the hyperlink text as the label for an object (by choosing it in the Labels dialog box). The 
hyperlink text is often what you click to jump to another page when you're browsing a Web page.



imagemap

A bitmapped graphic image that links to multiple URLs. In a Web site, imagemaps are often used 
as navigational tools: users can click different regions of an imagemap to jump to different objects
in the site.



inline

An attribute of an image or other object, indicating that the image is to be downloaded and 
displayed in the Web page and is not an imagemap.



Internet service

Any protocol for transferring information over the Internet, except  HTTP. The protocol is the first 
part of the full URL for an object. Internet service types include gopher, telnet, WAIS, NNTP, and 
FTP.



IP address

Internet Protocol address. A unique series of numbers that identifies a computer on the Internet. 



ISMAP

An attribute of an image (shown in the Properties dialog for that image), indicating that the image 
is an imagemap.



Java™

An object-oriented programming language, developed by Sun Microsystems Inc., that allows 
developers to create mini-programs (called applets) that can be embedded in Web pages and 
used across the Internet. Java programs are platform-independent, and feature real-time 
updating and interactivity—for example, stock quote "ticker tapes" that are updated every few 
minutes, interactive games, and animation.



label

In the map window, the Properties dialog box, and the results window,    the text describing an 
object or link. By default, the label for pages is the text in the TITLE tag. The default for all other 
objects is the Link URL.



link

On an HTML page, the code that links the page to another object. Different HTML tags are used 
to link different types of objects. For example, the IMG tag links to an image, the FORM tag links 
to a CGI script, and the APPLET tag links to a Java™ applet.



Link URL

The URL associated with the link on an object's parent page. The Link URL can be absolute (the 
full Internet address) or relative (the path name relative to the site's home page directory).



mailto

An electronic mail address, often in the form name@domainname.com.



main route

The first occurrence of a page or other object in a NetCarta WebMap™, displayed in black (if the 
object is onsite) or blue (if the object is offsite). The main route represents the first time a 
hyperlink points to the object. 



map window

The portion of the computer screen that contains the NetCarta WebMap™ of a site.



meta-WebMap

A NetCarta WebMap™ you create that consists of a collection of other WebMaps.



MIME type

The file type of an Internet resource. The MIME type has two parts: the general format of the file 
(the "major" type), and the more specific format (the "minor" type). For example, an image could 
have the MIME type image/gif or image/jpeg.



Name field

In the Properties dialog box, the place where you can enter a descriptive name for an object. You
can then choose Name as the first choice for that object type in the Labels dialog box. (For HTML
pages, the HTML TITLE text is used as the default Name.)



NetCarta WebMap™

A hierarchical representation of the objects and links in a Web site. The NetCarta WebMap™ is 
displayed in the map window.



NetCarta WebMap™ publisher

A person who creates WebMaps to share with others, using the Publish command.



NNTP (Network News Transfer Protocol)

A protocol that transfers Usenet news to Web sites on request.



Notes

In the Properties dialog box, optional annotations you can add to an object. Notes are saved with 
a published map, and are thus viewable by anyone who uses the map.



object

A page, image, audio or video file, mailto, gateway, application, or other resource in a Web site. 
All NetCarta WebMap™ objects are represented by icons and a text label.



offsite object

An object on a different site than the one that was originally mapped.



onsite object

An object that is part of the site that was originally mapped.



page

An HTML document.



parent page

The page above the selected object in the map hierarchy. The parent page contains links that 
point to its "children."



PDF (Portable Document Format) file

File type developed by Adobe™ Systems, Inc. that allows users to exchange and read files 
created with different software and/or on different computer systems. You need Adobe™ 
Acrobat™ to read PDF files. 



PostScript™ file

A type of text file developed by Adobe™ Systems, Inc. PostScript files contain text and 
instructions to printers that understand the PostScript "page description" language.



Properties dialog box

Dialog box where you can view or change information about the selected WebMap object.



protocol

The method by which computers communicate on the Internet. The most common protocol for 
the World Wide Web is HTTP. Other Internet protocols include FTP, gopher, and telnet. The 
protocol is part of the full URL for an object.



published WebMap

A WebMap that has been customized and saved to share with other CyberPilot™ Pro users. You 
use the Publish dialog box to determine which objects are saved with the published WebMap. 
Published WebMaps are compressed for faster transmission over the Internet.



results window

A type of CyberPilot™ Pro window that contains the results of a search or of a WebMap 
comparison. Each open map window can have a single results window. You can perform most of 
the same CyberPilot Pro operations in a results window as you can in a map window.



robot

A fast, automated program—such as a search engine, indexing program, or cataloging software
—that requests Web pages much faster than human browsers can. When CyberPilot™ Pro 
automatically explores a Web site, it    operates as a robot. Other commonly-used terms for robot 
include "crawler" and "spider." 



robot exclusion protocol

A "code of behavior" that is generally adhered to by robots (such as CyberPilot™ Pro when it 
automatically explores a site) when they attempt to access Web pages. Robot protocol usually 
involves restrictions on certain parts of a site, in order to avoid tying up the server with too many, 
too fast accesses. 



root directory

For a Web site, the directory on the site’s server that contains the home page.



telnet

Internet protocol that allows a user to log in to a remote computer, using a public or private 
account.



TITLE
On an HTML page, a text string at the top of the page that usually gives a descriptive name for 
the page. For WebMap pages, the Title text is used by default as the Name label. 



unexplored object

An object whose URL has not yet been found by CyberPilot™ Pro. An object gets explored when 
you click its question mark icon, or when you use the Explore command.



unreachable object

A page or other object that CyberPilot™ Pro cannot locate, because the URL is not valid, the 
object doesn’t exist, or the server containing the object is busy or having other technical 
difficulties.



URL (Uniform Resource Locator)

The Internet address for an object. A URL can be absolute (the full Internet address) or relative 
(the path name relative to the site’s home page directory).



Usenet news

News articles and information shared by Internet users. Usenet URLs are in the form 
news:name_of_newsgroup or news:message-id.



WAIS (Wide Area Information Server)
A method for searching and retrieving information from textual databases available on the 
Internet.



.WMP file

The file name extension of a saved Webmap.



Webmaster

The person who manages a Web site. 



CyberPilot™ Pro Basics 

A NetCarta WebMap™ gives you a graphical view of a Web site
You can use a WebMap as a table of contents for your favorite Web sites. Instead of wasting time
clicking hyperlinks to move from page to page, you can find what you're looking for right away by 
looking at a WebMap. Just as you'd refer to a road map while you're touring a city, you can look 
at WebMaps as you journey on the Web.

Use CyberPilot Pro and your Web browser together
CyberPilot Pro works side-by-side with your browser. Double-click a page or other object on the 
WebMap, and you'll see the page in the Web browser of your choice.

Cut down on server access
A WebMap lets you scan a site contents without having to "hit" the Web itself. Particularly if you 
have a slower connection to the Internet, you'll save valuable browsing time by hitting only the 
pages you're really interested in. Not only will you waste fewer hours of your own time, but you'll 
cut down on Internet traffic in general and save everyone time.

Use ready-made WebMaps or create your own
Use the WebMaps available from NetCarta's site--as well as from Lycos™, Point 
Communications™, and other WebMap repositories--or map any site on the World Wide Web. 
You can choose to build maps of a whole site, or only the parts you're interested in.

Customize your view of the WebMap
Design your WebMaps the way you like them. You can choose to hide or show particular site 
objects (for example, images or audio files), change the descriptive labels associated with 
objects, or even alter the navigation path through a site.

RELATED TOPICS
Where to find NetCarta WebMaps
What is a NetCarta WebMap?
Expanding or collapsing pages
How CyberPilot Pro works with your browser
Creating a new NetCarta WebMap
Exploring further: Building a NetCarta WebMap
Getting WebMap statistics



Where to find NetCarta WebMaps™

You can make WebMaps of your own, and you can use WebMaps created by other CyberPilot 
Pro users and WebMap publishers. Some Web sites feature ready-to-use WebMaps; just look for
this icon on a Web page:

Click the NetCarta WebMap icon to load the map into CyberPilot Pro, and you're ready to start browsing 
the site using the WebMap and your favorite Web browser. (If you haven’t already, you’ll need to 
configure CyberPilot Pro as your Web browser’s helper application for WebMaps.) 

You can also find ready-to-use WebMaps in the "WebMap Repository" section of NetCarta's Web
site (www.netcarta.com) You'll also see links to other sites that have WebMaps. If you use the 
Lycosª Web search engine (www.lycos.com), you'll find WebMaps on the Lycos site. Other 
sources of WebMaps include the Point Communicationsª site (www.pointcom.com) and the 
GeoCitiesª site (www.geocities.com)

Note: NetCarta's WebMap repository is a handy place to make your own WebMaps available to 
others. If you'd like NetCarta to publish your WebMaps for you, submit them to NetCarta's 
Webmaster (e-mail them to maps@netcarta.com) in saved format (not published).

RELATED TOPICS
Creating a new NetCarta WebMap
How CyberPilot Pro works with your browser
Publishing NetCarta WebMaps



What is a NetCarta WebMap™

A Web site consists of pages and other resources—such as images—and the hyperlinks (cross-
references on Web pages) that connect them. A WebMap displays all resources in the site in a 
tree-like hierarchy, which depicts how those resources are related to each other. Throughout the 
Help system, we refer to Web site resources as objects in the WebMap. 

Often, only pages are displayed in a WebMap, but there might also be other objects--such as 
images--in a Web site. These objects can be displayed in the WebMap, or they can be hidden. 
You can change what's displayed by adjusting CyberPilot Pro's display options.

RELATED TOPICS
WebMap object types
Showing or hiding types of objects
A note on the WebMap hierarchy



The Map window

A WebMap appears in a CyberPilot Pro map window, which can be controlled and manipulated 
like any other window in the Microsoft Windows™ environment. You can minimize the window so 
that it appears as an icon, and you can double-click to reopen it. You can also move and resize 
the window, or open multiple map windows to show different WebMaps.

RELATED TOPICS
How pages are shown in the WebMap
What the plus, minus, and question icons mean
What the label colors mean
Expanding or collapsing pages



How pages are shown in the WebMap

Each page in a WebMap is depicted by an icon like this:

Some WebMaps contain other object types, such as images or audio files. See WebMap object types for 
more information. 
To the right of the page icon is a label describing the page. You can accept the default label setting, 
change the default, or edit the settings to your liking using the Labels command on the View menu. 

RELATED TOPICS
Changing how objects are labeled
The map window
Expanding or collapsing pages



What the plus, minus, and question icons mean

Pages in a WebMap might be preceded by one of three smaller icons: plus, minus, or question 
mark.

The icons have the following meanings:

Plus: The page contains hyperlinks to other objects that are not shown; the hierarchy is 
collapsed at this point. If you click the plus, those objects lower in the hierarchy appear directly 
beneath the parent page, and the plus changes to a minus. The page is now fully expanded.

Minus: The page contains hyperlinks to other pages, and those pages appear directly beneath it.
You can click the minus icon to collapse the page so its children are no longer in view, and the 
minus changes to a plus.

Question mark: The page has not been explored; that is, CyberPilot Pro has not yet looked up 
any hyperlinks on the page. If you click a question mark icon, CyberPilot Pro looks up the page 
and examines it for hyperlinks. 

If there is no icon, the page has been fully explored and contains no hyperlinks to other pages. 
(There might be hyperlinks to other types of objects that are currently hidden, however; see 
Showing or hiding types of objects for more information.)

RELATED TOPICS
Expanding or collapsing pages
Exploring further: Building a NetCarta WebMap
How pages are shown in the WebMap
What the label colors mean



What the label colors mean

The different colored labels you might see in a WebMap are not there for decorative reasons. 
They're a way to help you quickly recognize what kind of object you're looking at:

Black: Onsite, main routes through the site.

Blue: Between-site objects and links.

Green: Onsite, alternate routes to an object.

Red: Any unreachable object (broken hyperlink). Red overrides any other color assignments.

RELATED TOPICS
Main and alternate routes (black and green labels)
Between-site objects (blue labels)
Unreachable objects (red labels)
Expanding or collapsing pages



Main and alternate routes (black and green labels)

Every object in the mapped site is represented exactly once in the hierarchy, with a black label. 
However, there may be more than one alternate route to the same object--that is, several 
hyperlink references to that object. These alternate routes are shown with a green label. Multiple 
routes to the same object are what makes the World Wide Web a web: there can be many cross-
connections between resources. So while there is only one instance of a particular object in a 
Web site, there may be several hyperlink references to the same object. 

A note about the green label: In new WebMaps, alternate routes are hidden by default, so you 
often won't see them unless you change display options. Also, alternate routes have green labels
only if they're onsite--part of the site you originally mapped. But if an alternate route is to a 
between-site object, its label will be blue, like other between-site objects.

There are several things you can do with alternate routes: you can change an alternate route into
the main route, display alternate routes with link icons, or prevent alternate routes from being 
expanded. 

RELATED TOPICS
How pages are shown in the WebMap
What the label colors mean
More on alternate routes
To show or hide all alternate routes
Using link icons for alternate routes
Labels available for alternate routes



Between-site objects (blue labels)

Many Web sites contain hyperlinks that point to other sites. Any hyperlink that points to an object 
on a site other than the parent page is a between-site object. CyberPilot Pro displays between-
site objects in blue.

RELATED TOPICS
How pages are shown in the WebMap
What the label colors mean
Automatically verify between-site pages



Unreachable objects (red labels)

When CyberPilot Pro can't reach a page or other object, it displays it with a red label. An object 
can be unreachable for several reasons:

The object no longer exists on the server, or the hyperlink is incorrect (an HTTP 404 error); the 
hyperlink is truly "broken."

The server on which the object resides is down; it has lost power or been disconnected.

The server is busy; there's a lot of Internet traffic going in and out of the site right now.

Your connection to the Internet is faulty.

The object requires a password (or other security procedure) for access.

Sometimes a page or other object is unreachable due to heavy traffic at a site or some other 
network problem. If an object is displayed in red for this reason, you can often wait for the traffic 
to subside and then successfully click the question    icon to explore the object. If CyberPilot Pro 
is able to reach the object this time, the label will no longer be red.

A hyperlink is truly broken if the object the hyperlink refers to has changed in some way. For 
example, the object may have been renamed, moved, or deleted from the site. Or the hyperlink 
itself may be incorrect. In that case, you might want to remap the site later to create a more 
accurate map (assuming the site's Webmaster has taken steps to fix the broken links!)

To see why a particular page or other object is unreachable, do the following:

Right-click it and check the status area of the Properties dialog box.

RELATED TOPICS
To determine why an object was unreachable
Changing how objects are labeled
WebMap object types



Expanding or collapsing pages

In the map window, any pages that contain hyperlinks to other pages are shown with either a plus
or minus icon to the left. There are three ways to expand or collapse a page:

Manually, by clicking plus or minus icons one at a time.

Automatically, with the Expand command.

Automatically, but for only part of the WebMap, with the Expand from Here command.

RELATED TOPICS
To expand or collapse a page manually
To expand or collapse pages with the Expand command
To expand or collapse a particular region of a WebMap



To expand or collapse a page manually

To expand or collapse any a page, just click the plus  or minus 

 icons. Click plus to expand the page, click minus to collapse it. If you've used the Microsoft Windows 
95™ Explorer or Microsoft Windows™ File Manager, you're familiar with how such a hierarchy works.

RELATED TOPICS
What the plus, minus, and question icons mean
How pages are shown in the WebMap
To expand or collapse pages with the Expand command
To expand or collapse a particular region of a WebMap



To expand or collapse pages with the Expand command

As an alternative to clicking the plus  and minus 

 icons one at a time, you can expand or collapse all or part of the map hierarchy with the Expand 
command on the View menu. And you can expand or collapse the hierarchy to a specified number of 
depth levels.
For example, to collapse a fully expanded view to two levels, do the following:
1. Choose Expand from the View menu.
2. Choose 2 from the submenu.
The WebMap hierarchy collapses to show all objects two levels deep. Any objects below that level will not
be shown, but their parent page will have a plus icon on the left.

Expand All fully expands the WebMap hierarchy. If your WebMap is big, you probably don't want 
to choose Expand All. This would make your map very large and difficult to use.

Note: Expanding the view does not explore (look up URLs for) Web objects. If you expand the 
view, question mark icons will appear next to pages that have not yet been explored. To explore, 
use the Explore command on the WebMap menu, or click question marks individually.

RELATED TOPICS
To expand or collapse a page manually
To expand or collapse a particular region of a WebMap
How pages are shown in the WebMap



To expand or collapse a particular region of a WebMap

You can expand or collapse the hierarchy in a particular region of a site. You may find this 
particularly useful with large sites, when you don't want to view the entire map in expanded form, 
but want a deeper look at just a part of it.

To expand or collapse a particular region of a WebMap, do the following:

1. Select the object from which you'd like to start expanding.

2. Click the right mouse button, or choose the Object menu.

3. Choose Expand From Here.

4. Choose how many levels you want to expand, then click OK.

RELATED TOPICS
How pages are shown in the WebMap
To expand or collapse a page manually
To expand or collapse pages with the Expand command
Showing or hiding types of objects



To open an existing WebMap

As with most programs that run under Microsoft Windows, there are several ways to open a 
WebMap. Once opened, the WebMap appears with the same display and label settings that were
in effect when it was last saved or published. Use one of the following methods to open a 
WebMap:

 Choose Open from the File menu.

The standard Windows File Open dialog box appears. Enter (or browse for) the name of the 
WebMap you want to open. The default file extension is WMP.

From the Desktop, Windows Explorer, or File Manager, drag any WMP file to the CyberPilot
Pro icon or into the map window. Or just double-click any WMP file.

CyberPilot Pro launches and opens the WMP file you selected.

 If you're browsing a Web site and see the WebMap icon, click it. CyberPilot Pro launches and 
displays the WebMap associated with the icon (usually a map of the site you were browsing). If 
you haven’t already, you’ll need to configure CyberPilot Pro as your Web browser’s helper 
application for WebMaps. 

RELATED TOPICS
Creating a new NetCarta WebMap
To change the default Web browser
To save a WebMap
Display Options dialog box
Labels dialog box



To save a WebMap

After creating or customizing a WebMap, you can save it to disk. Later, you can open the map 
from disk, and you won't have to spend time remapping the site. (If you created the map some 
time ago and think the site may have changed, you can use the Compare and Update command 
to compare your saved map to the current site.) 

To save a WebMap, do the following:

1.  Choose Save or Save As (to save the map under a new name) from the File menu. The 
standard Windows Save dialog box appears, suggesting the default WebMap file extension 
WMP.

2. Specify a file name and click Save.

The WebMap is saved with the display and label settings you are currently using.

If you intend to share your WebMap with other people, you may want to customize it for a 
particular browsing audience before saving it. For example, you could remove everything except 
pages about a particular subject. 

RELATED TOPICS
To open an existing WebMap
Compare and Update dialog box
Display Options dialog box
Changing how objects are labeled
Where to find NetCarta WebMaps
To publish a NetCarta WebMap



How CyberPilot Pro works with your browser

You can use a WebMap to quickly and efficiently travel within and between Web sites. When 
used in conjunction with your Web browser, WebMaps can save you a lot of browsing time.

You can also just move around the WebMap, without accessing the Web site itself. This is handy 
when you want to familiarize yourself with the structure and general content of a site, and don't 
want to take the time right now to browse the Web—just as you might study a road map before 
actually setting out on a journey. By using a WebMap, you'll cut down on Internet traffic, and 
pinpoint just the Web pages you most want to explore. You'll spend less time checking your 
watch, and more time browsing the most interesting areas of a Web site. If you want to view a 
particular page in your browser at any point, just double-click the icon or label next to the object 
you're interested in visiting. 

RELATED TOPICS
To view a page with your Web browser
To change the default Web browser
To desync the WebMap and your Web browser



To view a page with your Web browser

As you use CyberPilot Pro to look at pages in a WebMap, you'll frequently want to see the page 
you're jumping to in your Web browser window. When you double-click a page in the WebMap, 
CyberPilot Pro launches your Web browser and displays the page. If your browser is already 
launched, CyberPilot Pro sends it the URL for the selected page.

To view a page with your Web browser, do the following:

1. Double-click the WebMap page you'd like to view in your Web browser. Your Web browser will 
look up the URL for the selected page and display it.

2. If you like, rearrange the windows on your screen so that your browser and CyberPilot Pro are 
working side-by-side.

3. Continue double-clicking pages to browse the Web directly from your WebMap.

4. If there are other objects--such as audio or video files--in your WebMap, you can double-click 
them also. Depending on how your browser is configured, it either tries to view the object, or 
asks you to configure another helper application.

RELATED TOPICS
To change the default Web browser
To desync the WebMap and your Web browser



To desync the WebMap and your Web browser

When you navigate on the Web with your Web browser, the WebMap stays in sync with your 
browser; the selected object changes in the WebMap to reflect the page you've traveled to with 
your browser. So you can use the WebMap to track your progress through the site. 

However, you might prefer to keep your WebMap and browser activity separate. This way, you 
keep your context in the WebMap while you explore further in the site with your browser. You 
won't lose your place in the WebMap.

If you want to desynchronize the WebMap and your browser, do the following:

1. Choose Browser Configuration from the View menu.

2. Deselect the synchronizing checkbox.

3. Click OK.

Note: Of course, if the page you've traveled to in your browser is not an explored object in the 
active map window, it can't be selected (because CyberPilot Pro didn’t map that particular page).

RELATED TOPICS
To view a page with your Web browser
To change the default Web browser



To change the default Web browser

When you double-click a WebMap object, CyberPilot Pro displays the corresponding object in 
your Web browser. CyberPilot Pro always launches the most recently installed browser. If you 
have more than one Web browser on your computer, or if you want to change the default, you 
can configure another browser to use with CyberPilot Pro.

To change the default Web browser, do the following:

1. Choose Browser Configuration from the View menu.

2. Enter the path and name of the browser you want to use as the default in the Browser box. If 
you prefer, you can use the Browse button to locate the application.

3. Select the synchronizing checkbox if you want the objects to which you navigate in the 
browser to be simultaneously selected in the WebMap.

RELATED TOPICS
Browser Configuration dialog box



Creating a new NetCarta WebMap

You can use WebMaps created and published by others, and you can make your own. Making a 
new WebMap is a two step process: First, you give CyberPilot Pro the URL of the site you want 
to map. Then, you build the WebMap by clicking the question  icons or by using the Explore 
commands.

You can map an entire site, starting from the home page, or you can map part of a site. This strategy is 
particularly useful if the site you want to map is very large; it's quicker to map portions of a large site 
rather than the whole thing at once.

RELATED TOPICS
To create a new WebMap
What the question mark icon means
Exploring further: Building a NetCarta WebMap
Tips for mapping a large site



To create a new WebMap

To create a new WebMap, do the following:

1. Choose New Map from the File menu, or choose . The New Map dialog box appears.

2. Enter the URL of the site's home page in the Home Page Address box. Be sure to include the 
domain, but you don't need to precede it with http:\\. For example, to map NetCarta's site, 
you'd enter www.netcarta.com. 
Shortcut: If your Web browser is open, you can copy a URL from your browser's Location box 
and paste it to CyberPilot Pro's Home Page Address box.
TIP: If you like, you can begin mapping the site on a page other than the site's top-level home 
page. In that case, enter the URL of the page from which you want to start mapping in the 
Home Page Address box. For example, if you wanted to start mapping the NetCarta site from 
the Products area, you'd enter www.netcarta.com/prod/.

3. Click OK. A "Creating New Map..." status box appears. CyberPilot Pro looks up the URL you 
specified, and also checks to see if there is a default WebMap already on the site.

4. If you want to stop the creation process, click Cancel or press the Esc key. You would probably
only want to cancel creation if the site is very busy. Normally, the "Creating" status box should 
only appear for a very brief time.

CyberPilot Pro displays a label and an icon for the home page in the map window. If the page 
was found, the label is black. If CyberPilot Pro couldn't locate the page, the label is red.

If the home page contains any links to other objects (and most home pages do), you’ll also see a
 plus icon next to the label. You can click the plus to expand the home page and show its child 

objects. Since CyberPilot Pro has only located the home page so far, these child objects will have

 question mark icons next to them.To begin building the WebMap, click the question marks or choose the 
Explore command from the WebMap menu.

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
What the question mark icon means
Expanding or collapsing pages
What the label colors mean
If the site already contains a NetCarta WebMap
To build a WebMap with the Explore command
Explore dialog box



If the site already contains a NetCarta WebMap

At times, you may try to create a WebMap for a site that already has one. Some Webmasters 
have created WebMaps of their sites for your convenience. If a site contains a default WebMap 
(default.wmp) in the site's root directory, CyberPilot Pro detects it and displays it in the map 
window. Often this will be a complete map of the Web site. You can then use this prebuilt 
WebMap for browsing the site. Note that CyberPilot Pro only stops mapping if it finds this default 
WebMap; WebMaps deeper in the site will be shown as another object in the WebMap.

If there are any  question mark icons in the WebMap, you can continue exploring the site.

If you manage a Web site and want to create your own default WebMaps, see Publishing NetCarta 
WebMaps for more information.

RELATED TOPICS
Exploring further: Building a NetCarta WebMap



Exploring further: Building a NetCarta WebMap

With CyberPilot Pro, you can discover the structure of as much (or as little) of the site as you like.
That is, you can have CyberPilot Pro look up the URLs for all pages and other objects linked to 
them in the site, or you can choose to look up (explore) only some of them.

If you let CyberPilot Pro explore the entire site and build a complete WebMap, you'll be able to 
view and work with all objects and links in the site. If the site is very large, however, you may 
want to limit exploration, since it could take a long time to build a complete map, especially if your
connection to the Internet is slow. Also, a WebMap of a big site can be very large and 
unmanageable. See Tips for mapping a large site for more details.

There are three ways to explore a site—or part of a site:

 Click the question mark icon next to any unexplored page

 Choose Explore from the WebMap menu

Right-click a page in the WebMap and choose Explore from Here

Depending on how you build the WebMap--manually or automatically--the WebMap hierarchy 
may be built differently. See A note on the WebMap hierarchy.

RELATED TOPICS
Creating a new NetCarta WebMap
What the question mark icon means
Exploring sites that restrict robots (crawlers)



What the question mark icon means

A page that is accompanied by a  question mark icon is unexplored—that is, CyberPilot Pro has 
not looked up its URL and does not yet know anything about it. 

When you click a page's question mark icon, or use the Explore command to build the WebMap 
automatically, the question mark icon will do one of the following:

Disappear, if the page was accessed and contains no hyperlinks. 

Turn into a  minus, if the page was accessed and contains one or more hyperlinks. 

Remain a question mark, if CyberPilot Pro couldn't access the page (because its URL isn't valid, or there 
are problems with the server or Internet connection). In this case, the label turns red, indicating that the 
page is unreachable.

If any objects (such as images or audio files) have been hidden from view, there may be no plus 
or minus sign, even though those objects are actually contained in the WebMap. See Showing or 
hiding types of objects for more information.

RELATED TOPICS
To create a new WebMap
Exploring further: Building a NetCarta WebMap
Expanding or collapsing pages
Unreachable objects (red labels)



To build a WebMap with the Explore command

As an alternative to clicking the  question mark icons for individual pages, you can use the 
Explore command on the Toolbar to automatically look up URLs in a WebMap.

To automatically look up URLs in a WebMap, do the following:
1. Choose Explore from the WebMap menu, or click . The Explore dialog box appears.
2. Set up the Explore options as you want them.
3. Click OK.
A status box appears, showing a running count of all objects and hyperlinks in the site. The list is 
dynamically updated as objects are found by CyberPilot Pro. You can click Stop or press Esc to halt 
exploration at any time; the resulting WebMap will contain all objects and hyperlinks found so far.

Choose from this list for information about each of the options in the Explore dialog box:

Automatically verify between-site pages
Limit the number of pages to explore
Limit the explore level

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
To map a particular region of a site
To create a new WebMap
Tips for mapping a large site



Automatically verify between-site pages (Explore dialog box)

Most Web sites contain hyperlinks to pages on other sites. CyberPilot Pro displays these 
between-site links in blue, with a  question mark icon. You can click question marks individually 
to look up the URLs for pages on another site. When exploring a site, CyberPilot Pro does not 
automatically look up the URLs for between-site objects. That's because it can take a long time to
verify the existence of between-site objects, particularly if the site you're mapping is large and 
has many links to other sites.

However, if the site isn't too large, you might want to have CyberPilot Pro look up all between-site
pages as it explores. To do so, select the Verify Links to Other Sites checkbox in the Explore 
dialog box. CyberPilot Pro will then try to look up hyperlinks to other sites. Depending on network
traffic and the speed of your Internet connection, this may take some time. Any unreachable 
objects will appear in red. 

Note: CyberPilot Pro only verifies that each first-level, offsite object exists. That is, it doesn't look 
up any of the hyperlinks on an offsite page, so a  question mark still appears next to the offsite 
object. This prevents CyberPilot Pro from infinitely exploring every object in other sites, which 
could also be linked to yet other sites. You can click question marks for offsite pages individually 
to explore further. 

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
Tips for mapping a large site
Between-site pages (blue labels)
Unreachable objects (red labels)



Limit the number of pages to explore (Explore dialog box)

To save time, you can tell CyberPilot Pro to automatically map only so many pages in a site. This 
is useful if a site is large, or if you prefer to explore parts of the site manually by clicking individual
 question marks. By default, the Page Limit is set to 100 pages. You can enter a different number

if you want CyberPilot Pro to map more or less of the site. You cannot leave this box blank; you 
must enter some limit.

However, if you enter a number greater than 500, a warning message appears, recommending that you 
enter a smaller limit. It takes a long time to map a site greater than 500 pages, and such large WebMaps 
are unwieldy and difficult to use and publish. Also, automatic exploration of such a large site can bog 
down the server hosting the site. It's better to create several smaller WebMaps of a large site instead of 
attempting to map the whole thing at once. See Tips for mapping a large site for more large-site 
strategies.

Some notes about the page limit: The Page Limit setting is incremental: Each time you use the
Explore command  and specify a number for the Page Limit, CyberPilot Pro adds the specified 
number of pages to those already explored in the map. For example, if you click question mark 
icons, or use the Explore command to explore 50 pages, then use the Explore command again 
and specify 100 pages, those 100 pages will be added to the 50 that have been explored.

Note that the total number of pages explored may be fewer than you expect. That’s because 
CyberPilot Pro adds a page to your WebMap when it finds a hyperlink that points to that page. 
This means it will only request enough pages from the server as needed to find the number of 
hyperlinks that meet the page limit you’ve set. And since most pages contain multiple hyperlinks, 
CyberPilot Pro will usually retrieve far fewer pages than the number you specify as the limit. For 
example, say you set your Page Limit to 100. CyberPilot Pro could reach the 100 page limit after 
examining only the first 5 pages it retrieves (if those pages contain 20 hyperlinks each), or the 
first 20 (if those pages contain 5 hyperlinks each). CyberPilot Pro will not normally have to 
access the server 100 times.

Once CyberPilot Pro has begun exploring a page, it must explore every hyperlink on the page; it 
can’t stop part way through a page. This means that CyberPilot Pro may sometimes slightly 
exceed the Page Limit. For example, if CyberPilot Pro examines 4 pages, each containing 22 
hyperlinks, it will then go on to examine the next page (since it has only mapped 88 pages so 
far). If that page also contains 22 hyperlinks, CyberPilot Pro will add those 22 hyperlinks to the 
WebMap, for a grand total of 110 pages.

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
A note on the WebMap hierarchy
To map a particular region of a site
Tips for mapping a large site



Limit the Explore Level (Explore dialog box)

 In the Explore dialog box, select the Limit Levels checkbox to limit the exploration to a particular level in 
the WebMap hierarchy. You can enter any number, though you may want to limit exploration to 2 or 3 
levels. Otherwise, it may take a long time to build the WebMap, particularly if your Internet connection is 
slow or network traffic is heavy. 

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
Tips for mapping a large site



To map a particular region of a site

If you’re interested in exploring only a particular region of a site more deeply, or if the site you’re 
mapping is large, you may want to map only a portion of the site.

To map a particular region of a site, do the following:

1. Select the page in the map from which you want to start exploring.

2. Click the right mouse button, or choose the Object menu.

3. Choose Explore From Here. The Explore dialog box appears.

4. Set the Explore dialog box options as you like them, then click OK.

CyberPilot Pro looks up the URLs for all onsite     objects   from this point forward. You may find this 
particularly useful with large sites, when you don't want to spend the time required to explore the 
entire site, but want to quickly analyze part of it. Note that, to save time, any objects in another 
site--shown in blue in the WebMap--will not be automatically verified unless you select the Verify 
Links to Other Sites checkbox.

Note: Because you are exploring only part of a site and leaving other regions unexplored, 
CyberPilot Pro builds the WebMap hierarchy differently than it does when it explores the whole 
site at once. See A note on the WebMap hierarchy for more information.

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
Expanding or collapsing pages
To create a new WebMap



A note on the WebMap hierarchy

 When you build a map with the Explore command, CyberPilot Pro locates the home page you specified 
and displays it. Next, CyberPilot Pro looks up all hyperlinks on the home page and displays them. It then 
looks up the hyperlinks on those "child" pages and displays them, and so on. This process of building a 
hierarchy (sometimes called a tree) is known as breadth-first: objects are explored and displayed one 
level at a time. 

The result is the hierarchical view of the site you see in the map window—a linear, visual outline 
of the site's structure. But the WebMap hierarchy isn't set in stone. It all depends on whether it's 
built automatically or manually. For instance, you might want to look more deeply at a region that 
is not yet explored. So, instead of using the Explore command to automatically build the 
hierarchy, you could click  question marks individually to build the WebMap. You could choose to
explore a page that would have been three levels down in the hierarchy if CyberPilot Pro had 
built the WebMap automatically. As a result, the WebMap hierarchy could look quite different. 

So, despite the structured way a WebMap is built, the same Web site could spawn multiple 
WebMaps with very different structures!

RELATED TOPICS
Exploring further: Building a NetCarta WebMap
What the question mark icon means
Exploring sites that restrict robots (crawlers)
The map window
Creating a new NetCarta WebMap



Exploring sites that restrict robots (crawlers)

When CyberPilot Pro explores an entire site, it operates as an automated robot—that is, it 
requests many Web pages in a very short period of time, far faster than you could do by clicking 
question marks. (Robots are also sometimes called crawlers in Internet parlance.) When 
exploring a site automatically, CyberPilot Pro obeys any robot exclusion protocol that has been 
enabled for a site. Robot exclusion protocol prevents the site's server from becoming bogged 
down with too many "hits" (accesses).This can be a real problem with popular sites, which may 
receive hundreds of thousands of hits per day.

When CyberPilot Pro encounters a site with an area that restricts robots, it stops exploring that 
region of the map. When the WebMap appears in the map window, any object that could not be 
accessed because of the site's robot exclusion protocol is shown with this Robot icon:

CyberPilot Pro is affected by robot protocol only when you choose to explore the site automatically (with 
either the Explore or Explore From Here command). If you explore a site "manually" by clicking question 
mark icons individually, any robot protocol for the site will be ignored by CyberPilot Pro (since you aren't 
operating as an automated robot). So if you've used the Explore command, and see Robot icons in your 
WebMap after exploration, you can always click the question mark(s) later to explore that area of the site.

Note: In general, you can help prevent server overload and practice good "netiquette" by not 
automatically exploring large sites (over 500 pages). Instead, try creating several WebMaps for 
different regions of the site. 

RELATED TOPICS
What the question mark icons mean
To build a WebMap with the Explore command
Limit the number of pages to map
The map window
Tips for mapping large sites



Tips for mapping a large site

Depending on the speed of your network connections and the load on the server where the site 
resides, it can take a long time to explore a large, complex site. If the site you want to map is 
quite large--say, more than 500 pages--consider these recommendations to save time and cut 
down on Internet and server traffic:

Make separate WebMaps for different areas of the site. Try creating several WebMaps of one 
site, each starting at a different point. Rather than generating a WebMap from the site's home 
page, you can begin mapping at any page. For instance, for a large corporate site that covers 
many different products, you could create a map for each different product area. Just enter the 
URL for any page in the Home Page Address box in the New Map dialog box. You can then save 
the WebMaps under different names and use them later to browse areas of the site.

After creating the map with the New Map command, explore the rest of the site manually. 
When creating a WebMap, CyberPilot Pro looks up the URL for the home page and presents it 
with a  plus icon next to it. If you click the plus, you’ll see any hyperlinks CyberPilot Pro found on
the home page, with question marks next to them. Instead of using the Explore command, you 
can click question marks individually to explore the areas of the site you're most interested in. 

Limit exploration of the site. If you do explore the site automatically, be sure to define limits in 
the Explore dialog box. You can enter a number in the Page Limit box to set a maximum number 
of pages to explore. If you enter a number greater than 500, CyberPilot Pro displays a warning 
message. You can also choose to limit the explore level. As an alternative, use the Explore from 
Here command on the Object menu to begin exploration from a certain point in the WebMap.

Click individual question marks to verify links to other sites. In the Explore dialog box, make
sure that the Verify Links to Other Sites checkbox is deselected. Verifying links to other sites 
creates more Internet traffic. If the network is busy, this process can be time-consuming. You can 
always explore the offsite objects manually by clicking  question marks later.

Test a large site to see if you've mapped far enough. For your initial exploration of the site, in the 
Explore dialog box, set the Limit Levels To checkbox to 3 levels. Then, in the Search dialog box, search 
for all objects at Level 3. If you see mostly green labels for objects in the Search Results window (that is, 
alternate routes), you've probably mapped most of the new material in the site.

Save large maps. If you've taken the time to map and fully explore a large site, you'll probably 
want to save the WebMap to disk so you can use it again later (rather than spending time 
remapping the site).

RELATED TOPICS
Creating a new NetCarta WebMap
Exploring further: Building a NetCarta WebMap



Getting WebMap statistics

When CyberPilot Pro first explores a site, it gathers information about the site: the site's URL, 
and how many pages and other objects were found when CyberPilot Pro mapped the site. For a 
quick overview of the site, you can view this data in the Statistics dialog box. All of the fields are 
read-only; you can't edit any of the information. 

RELATED TOPICS
Viewing and changing object properties



Statistics dialog box

 To see the Statistics dialog box, choose Statistics from the WebMap menu. The dialog box contains two 
tabbed pages: General and Object Count.

General tab (Statistics dialog box)

The fields in the General tab are described in the following table:

Field Name Description

Domain The unique name of the server computer for the mapped
site. The file extension represents the type of operation 
the site is involved in; for instance, .COM for business 
or .EDU for an academic institution. For example, 
NetCarta's domain is www.netcarta.com.

Root Path The directory path of the site's home page (on the server
computer).

Home Page The page from which you began mapping a Web site. 
This is often the site's home page, but could be any page
in the site.

Object Count tab (Statistics dialog box)

The Object Count tab displays the number of objects and links in the WebMap: pages, 
hyperlinks, images, gateways, audio or video files, Internet services, text files, other applications, 
and any unrecognized MIME types.

RELATED TOPICS
Creating a new NetCarta WebMap
Viewing and changing object properties





Displays the New Map dialog box where you can enter a URL name to create a new NetCarta 
WebMap™.



Displays the Open dialog box where you can open an existing map file.



Closes an opened map file.



Closes all the opened map files.



Saves the current map file with the current file name.



Displays the Save As dialog box where you can save the current map file with a specified file name.



Displays the Publish dialog box where you can specify a map file to publish.



Opens the most recent map file you worked in.



Exits the CyberPilot™ Pro application.



Displays the Display Options dialog box where you can show or hide objects in the WebMap hierarchy 
and where you can display objects as link icons.



Displays the Labels dialog box where you can change how objects are labeled in the WebMap 
hierarchy.



Displays the Browser Configuration dialog box where you can change your default Web browser and 
desync your Web browser from the WebMap.



Shows or hides the Toolbar.



Shows or hides the Status Bar.



Expands the current WebMap one level.



Expands the current WebMap two levels.



Expands the current WebMap three levels.



Explands the current WebMap to as many levels as exist.



Displays the Explore dialog box where you can have CyberPilot™ Pro look up URLs automatically and 
where you can narrow the scope of exploration.



Displays the Search dialog box where you can enter search criteria to look for particular objects in a 
Web site.



Displays the Compare and Update dialog box where you can compare two WebMaps on a site.



Displays the Statistics dialog box where you can view information about the objects in the WebMap.



Launches your Browser.



Expands the WebMap one level from the selected object.



Expands the WebMap two levels from the selected object.



Expands the WebMap three levels from the selected object.



Expands the WebMap to as many levels as exist for the selected object.



Explores the WebMap from the selected object.



Takes you to the main route of the selected object.



Makes the route of the selected object the main route.



Displays the Properties dialog box where you can view property information about the selected object 
and where you can hide an object individually and hide alternate routes to an object.



Arranges the windows in a overlapped, diagonal manner.



Arranges the windows in a vertically-tiled manner.



Automatically arranges the icons to a pre-set position.



A dynamic list of all open windows.



Displays the Help Topics dialog box, which contains the Contents tab, the Index tab, and the Find tab.



Displays the CyberPilot™ Pro Help screen where you can click the icons next to each major section 
and automatically jump to that section in the Help system.



Displays the Microsoft™ Windows Help, which describes how to use Windows 95 Help.



Displays a window that contains version information and licensing information about CyberPilot™ Pro.



Open dialog box

The Open dialog box is accessed from the File menu. Use this dialog box to open an existing 
NetCarta WebMap™.

Field Description

Look in Select the directory in which you want to open a map file.

Name Select the map file name of the map you want to open. When 
you select the map file name, that name appears in the File 
name box. If you double-click the map file name, CyberPilot 
Pro opens that map file.

File name Enter the map file name that you want to open.

Files of type A drop-down list of the types of files available to you.

Save As dialog box

The Save As dialog box is accessed from the File menu. Use this dialog box to save a NetCarta 
WebMap™.

Field Description

Save in Select the directory in which you want to save a map file.

Name Select the map file name of the map you want to save. When 
you select the map file name, that name appears in the File 
name box. If you double-click the map file name, an 
information window appears asking if you want to overwrite the
existing file name.

File name Enter the map file name that you want to save.

Files of type A drop-down list of the types of files available to you.

Map window

The CyberPilot™ Pro map window can be controlled and manipulated like any other window in 
the Microsoft Windows™ environment. The map window can contain a NetCarta WebMap™, a 
search results window, and a comparison results window. 



You can minimize the window so that it appears as an icon, and you can double-click to reopen it.
You can also move and resize the window, or open multiple map windows to show different 
WebMaps.

RELATED TOPICS
How pages are shown in the WebMap
What the plus, minus, and question icons mean
What the label colors mean
Expanding or collapsing pages



New Map dialog box

The New Map dialog box is accessed from the File menu. You use the New Map dialog box to 
create a new NetCarta WebMap.

Field Description

Home Page Address (URL) Enter the URL of the site’s home page, 
including the domain. You don’t need to 
include http:\\.

Shortcut: Ctrl+N

TIP: If your Web browser is open, you can copy a URL from your browser's Location box and 
paste it to CyberPilot Pro's Home Page Address box.

If you want to stop the creation process, click Cancel or press the Esc key. 

RELATED TOPICS
To create a new WebMap
To open an existing WebMap
To save a WebMap
Exploring further: Building a NetCarta WebMap
Unreachable objects (red labels)



Explore dialog box

The Explore dialog box is accessed from the WebMap window. Use the Explore dialog box to 
automatically look up URLs in a WebMap and to narrow the scope of exploration.

Field Description

Page Limit Limits the number of pages that will be explored in the 
WebMap hierarchy. The default is 100 pages. 

Limit Levels to: Limits the number of levels that will be explored in the 
WebMap hierarchy. You can enter any number, but limiting to
2 or 3 levels is the most efficient.

Verify Links to Other 
Sites

When checked, CyberPilot Pro looks up hyperlinks to other 
sites.

Shortcut: Ctrl+X

RELATED TOPICS
To build a WebMap with the Explore command
To map a particular region of a site
A note on the WebMap hierarchy
Exploring further: Building a NetCarta WebMap



Publish dialog box

The Publish dialog box is accessed from the File menu. You use the Publish dialog box when you
want to publish a map that you have created.

Field Description

Publish To Enter the path and file name for the published map. Use 
the Browse button to help determine the path and file 
name. The .WMP extension is appended automatically to 
the file name.

Publish All Objects Select this option to include all object types. All the 
choices are dimmed; you cannot individually deselect any 
options. Only main-route objects are included unless you 
select Publish Alternate Routes.

Publish Only Select object types individually to publish. By default, the 
settings in this list match the WebMap’s current display 
options. Only main-route objects are included unless you 
select Publish Alternate Routes. “Pages” are not included 
in this list because they’re always published with a map.

Select All Click this button to select all the objects. You can then 
deselect one or two objects if you want to.

Clear All Click this button to clear all the options.

Publish Alternate Routes Select this option to include alternate routes to the 
selected object types.

Load Default Click this button if you want to use the alternate default 
settings that ship with CyberPilot Pro or that you set up 
yourself with the Save As Default button.

Save As Default Click this button if you want to change the NetCarta 
alternate default settings to the way you currently have 
the dialog box set up. From this point on, when you click 
Load Default, the Publish dialog box displays these 
settings.

RELATED TOPICS
To publish a NetCarta WebMap
To use NetCarta’s WebMap repository
Charting new ground: Advanced map making





Display Options dialog box

The Display Options dialog box is accessed from the View menu or by clicking the ….icon on the 
Toolbar. Use this dialog box when you want to show or hide objects in the WebMap hierarchy, and 
when you want to display objects as link icons.

Option Name Description

Show All Objects Shows all objects in the WebMap. When you select this 
checkbox, all listed objects are dimmed, indicating they will 
all be shown in the WebMap.

Show Only Shows the objects you choose in the WebMap. Available 
only when Show All Objects is deselected.

Select All Selects all the objects. 

Clear All Deselects all the objects.

Show Alternate Routes Shows <link>alternate routes to objects. 

Within Page Shows alternate routes that are on the same page.

Allow Expansion Allows alternate routes to be expanded.

Display As Displays alternate routes with either object icons (the 
default) or link icons. 

Load Default Loads the default display options.

Save As Default Saves the current display options as the default. Note: If you
change the default settings and save them, you override the 
settings that come withCyberPilot Pro. To return to the 
original settings, set them manually and click Save As 
Default.

Display Options default settings

Display Option Default Setting

Show All Objects Deselected

WebMaps Selected

Show Alternate Routes Deselected



Allow Expansion Selected

Display [Alternate Routes] As Objects Selected

RELATED TOPICS
WebMap object types
To show or hide object types
To show or hide all alternate routes
More on alternate routes
To allow or disable expansion of alternate routes
Using link icons for alternate routes



Search dialog box

The Search dialog box is accessed from the WebMap menu. You use the Search dialog box to 
search for particular objects, for example, certain kinds of pages or images, and to search for 
links. For a detailed description of all the fields in the Search dialog box, see <link>Setting up the 
Search dialog box and all the related topics from that topic.

Field Description

Search Specifies which part of the WebMap you want to search.

Object Type Specifies whether you want to search for all objects that match 
the criteria for a particular object type. You can also search for 
links.

Field Type Specifies what WebMap field you CyberPilot Pro to search in. 
The available field options are determined by what you choose 
in the Object Type list.

Modifiers Specifies which search modifier you want to apply. The Field 
Type option determines which modifiers are available.

Text String/Value Specifies a text string if you’re performing a text search, a 
numeric value if you’re performing a numeric search, or TRUE 
or FALSE.

Advanced button Expands the Search dialog to include the additional search 
criteria. You can then click the Basic button to redisplay the 
basic, single search criteria.

Match case When checked, searches for the text string using the exact 
capitalization you type.

RELATED TOPICS
To perform a simple text search
To get extra mileage from a results window
To specify advanced search criteria
About searching for objects versus links
Link icons in search results



Labels dialog box

The Labels dialog box is accessed from the View menu or by clicking the >>> icon on the 
Toolbar. You use this dialog box to change how objects are labeled in the WebMap and to save 
your label settings as the defaults.

Field Description

Apply to All Object Types Uses the same labels for all object types

Object Type Specifies a specific object type. The labels available 
for each object type are shown in the First Choice 
drop-down list.

First Choice Shows the labels available for the specified object 
type.

If First Choice not Available An alternate label choice for the specified object type 
if the first one is not available.

Load Default button For existing maps, click this button to use the default 
settings you saved.

Save As Default button Saves the label settings as the default to be used 
with all new maps. Existing maps use the label 
settings you set for them.

RELATED TOPICS
Changing how objects are labeled
To change the label for an object type
To change the label for a particular object
Object types in the Labels dialog box



Browser Configuration dialog box

The Browser Configure dialog box is accessed from the View menu. Use this dialog box to 
change the default Web browser and to desynchronize the WebMap from your browser.

Field Description

Browser Path and name of the browser you want to use 
as the default. You can use the Browse button to 
locate the application.

When browsing, synchronize 
WebMap to browser location

When checked, the WebMap stays in sync with 
your browser; the selected object changes in the 
WebMap to reflect the page you’ve traveled to 
with your browser. When unchecked, the 
WebMap and browser are no longer in sync.

RELATED TOPICS
How CyberPilot Pro works with your browser
To view a page with your Web browser
To desync the WebMap and your Web browser
To change the default Web browser



Compare and Update dialog box

The Compare and Update dialog box is accessed from the WebMap menu or by clicking the ……
icon on the Toolbar. Use this dialog box when you want to ensure that the WebMap you’re using 
matches the current state of the site.

Field Description

Source WebMap The map with customizations you want to 
preserve, usually the older of the two maps.

Target WebMap The map that you may want to update with the 
source map’s customizations, usually the newer
of the two maps.

Report on Changed and New 
Objects in Target WebMap

Generates a comparison result for objects in the
source map that aren’t found in the target map.

Report on Orphaned Objects in 
Source WebMap

Generates a comparison result for new and 
changed objects in the target map.

Update annotations from Source 
WebMap to Target WebMap

Updates the target map with the customizations
of the source map.

RELATED TOPICS
Comparing and updating WebMaps
Comparing before updating
Narrowing the scope of comparison results
To work with comparison results



General tab (Statistics dialog box)

The Statistics dialog box is accessed from the WebMap menu or by clicking the …..icon on the 
Toolbar. Use this dialog box when you want to see information about the site. There are 2 tabs: 
General and Object Count.

Field Description

Domain The unique name of the server computer for the mapped 
site. The file extension represents the type of operation 
the site is involved in; for instance, .com for business 
or .edu for education.

Root Path The directory path of the site’s home page (on the server 
computer).

Home Page The page from which you start mapping a Web site. 
Usually the home page, but can be any page in the site.

CGI Bin Directory The directory on a server where Common Gateway 
Interface script programs are stored.

RELATED TOPICS
Getting WebMap statistics
Creating a new NetCarta WebMap
Viewing and changing object proerties



Object Count tab (Statistics dialog box)

The Statistics dialog box is accessed from the WebMap menu or by clicking the …..icon on the 
Toolbar. Use this dialog box when you want to see information about the site. There are 2 tabs: 
Object Count and General.

The Object Count tab displays the number of objects and links in the WebMap: pages, 
hyperlinks, images, gateways, audio or video files, Internet services, text files, other applications, 
and any unrecognized MIME types.

RELATED TOPICS
Getting WebMap statistics
Creating a new NetCarta WebMap
Viewing and changing object proerties



Properties dialog box

The Properties dialog box is accessed from the Object menu, or from the shortcut menu (select 
the object, right-click, and then select Properties), or by clicking the ….icon on the Toolbar. Use 
this dialog box to view an object’s properties, to hide an object individually, or to hide alternate 
routes to an object. 

The Properties dialog box can stay on your screen at all times, and it changes dynamically; as 
you select each object, the properties change accordingly.

Field Description

Full URL The full URL (Uniform Resource Locator) or Internet address for 
an object, including the protocol and domain name. For 
example, http://www.netcarta.com.

Name By default, this is the HTML TITLE tag for pages. (There is no 
default for other objects.) You can change the Name to anything 
you like.

Notes You can enter notes about any object. If you’ve entered no other 
notes, the hyperlink text appears in the Notes field.

Hide All Routes and 
Hide All Alternate 
Routes

These checkboxes let you hide all routes to an object or just the 
alternate routes. For example, you might have a customized 
WebMap that shows all images, but decide you want to hide a 
particular .gif. You can choose Hide All Routes, and all instances
of that gif object will be hidden.

Service Type The application protocol, such as http, ftp, mail, news, gopher, 
wais, unknown. 

MIME Type The major and minor MIME types, for example, image/gif.

Status Indicates if the object is explored or unexplored. If an object was 
<gloss>unreachable, there is also a code number and 
description explaining why it was unreachable.

RELATED TOPICS
Viewing and changing object properties
Showing or hiding individual objects
To hide all alternate routes to an object
To change the name of an object
To create and view notes



Empty Properties page

The Empty Properties page appears when you have selected an object that has no properties. 
Select an object with properties to display the Properties dialog box.

RELATED TOPICS
Properties dialog box
Viewing and changing object properties
Showing or hiding individual objects



About CyberPilot™ Pro

CyberPilot™ Pro is the advanced navigation tool for mapping the World Wide Web and for 
introducing you to the world of cyberspace cartography. When you use CyberPilot Pro with your 
favorite Web browser, you find information more quickly because you can see the entire Web site
at a glance and can choose exactly what you want to see in your browser.
For more information on our exciting product, see Take off with CyberPilot™ Pro.



 CyberPilot™ Pro Contents

Enter the world of cyberspace cartography 
with CyberPilot™ Pro, the advanced 
navigation tool from NetCarta Corporation 
for mapping the World Wide Web.

Choose from the following topics to explore the world of cyberspace cartography:

 Take off with CyberPilot Pro: Overview of NetCarta WebMaps, and introduces the features and 
concepts of NetCarta WebMaps.

 CyberPilot™ Pro Basics: Introduces the elements of a NetCarta WebMap, how to navigate the World 
Wide Web using CyberPilot Pro, and how to make your own WebMaps.

 Customizing a NetCarta WebMap™: Presents in detail how objects are labeled, which labels are 
available, and how to change object properties.

 Searching and Comparing NetCarta WebMaps™: Details simple keyword search instructions, how to 
set search criteria and work with search results, and how to compare and update WebMaps.

 Publishing NetCarta WebMaps™: Explains how to publish a NetCarta WebMap, how to add a 
published WebMap to your Web site; and presents publishing tips and techniques.

 Glossary: Definitions of terms, in alphabetical order.

 Keyboard Shortcuts: Lists the menu equivalents of menu commands.

 Menu Commands: Descriptions of each menu command.



 Take Off with CyberPilot™ Pro 

Welcome to the                      world of cyberspace 
cartography with CyberPilot™ Pro,            the advanced 
navigation tool for mapping the                  World Wide 
Web. CyberPilot Pro, together with              your favorite 
Web browser, lets you see the entire Web      site at a 
glance and choose exactly what you want to see      in your
browser.

Choose from these topics to read about the exciting features of CyberPilot™ Pro and what it can 
do for you and your Web site:

Take a trip to Hawaii with CyberPilot™ Pro (our tutorial!)
Enter the NetCarta WebMap™
Save valuable browsing time
Choose what you want to see, when you want to see it
Search NetCarta WebMaps and get there even faster
Customize NetCarta WebMaps™ for browsing and publication
Keep your NetCarta WebMaps™ up-to-date
NetCarta WebMaps™ are popping up all over the Web



 Take a trip to Hawaii with CyberPilot™ Pro (our tutorial!)

Before you take off with CyberPilot Pro on your own, you may want to work through the brief 
tutorial A Trip to Hawaii with CyberPilot Pro, located in the following directory, netcarta\pilotpro\
tutorial, on your disk. The tutorial shows you how to use the basic features of CyberPilot Pro. 
After working through the tutorial, use the Help system to learn more about CyberPilot Pro and its
advanced features.

Welcome to the world of cyberspace cartography.



 Enter the NetCarta WebMap™

A NetCarta WebMap shows you an entire Web site in an easy-to-understand, visual format. A 
WebMap includes graphical representations of the objects in a Web site, such as HTML pages 
and graphic images; audio, video, and program files; Java, PDF, or Word files; Internet services 
such as gopher and FTP; and so on. A WebMap displays the objects in a hierarchical view that 
represents the relationships between the objects.

With CyberPilot Pro, not only can you create your own WebMaps of favorite sites, but you can 
also use the WebMaps that are integrated into the sites you visit. If a site includes hyperlinks to 
other sites on the Web, you can use the same WebMap to explore those sites too. There’s 
virtually no limit to how far you can explore using a NetCarta WebMap.



 Save valuable browsing time

CyberPilot™ Pro saves you valuable browsing time. No more guessing where to go when you 
arrive at a site. No more wading through multiple levels of pages that take forever to load only to 
find that you’re not where you wanted to be after all. With CyberPilot Pro, you create NetCarta 
WebMaps™ of the sites that interest you, use the maps to quickly find what you’re looking for, 
and load only those items into your browser. Whether you browse the Web as part of your job or 
just for fun, you’ll be amazed at how efficient and frustration-free browsing can be when you use 
NetCarta WebMaps to help you navigate.

As you use CyberPilot Pro to map your favorite Web sites, you may want to publish your 
WebMaps to share with other Web users. As CyberPilot Pro users share more and more of their 
WebMaps, you won’t have to create as many yourself. 

If you manage a Web site, you can include NetCarta WebMaps to maximize your user’s 
experience of the site. Visitors find what they’re looking for quickly with less fuss, so they’re more
likely to visit again. And, because WebMap users look only at the specific pages they’re 
interested in, the Web server takes fewer hits. Traffic congestion at your site is greatly reduced, 
so more people can visit.



 Choose what you want to see, when you want to see it

Power-browsing is as simple as examining a WebMap to pinpoint what you want to see, double-
clicking the map object, and watching that page or image appear in your browser. Many 
WebMaps even include notes to help you decide what you really want to see. 

Unlike navigating with a Web browser alone, CyberPilot Pro helps you understand where you 
are, no matter how far you’ve wandered in a Web site. With just a browser, it’s easy to get lost in 
a complicated browsing session, but with CyberPilot Pro, you always have your WebMap to 
guide you. 



 Search NetCarta WebMaps™ and get there even faster

To find information even faster, you can do a search of your NetCarta WebMaps. For example, 
let’s say you’ve mapped your favorite Web site. You know that one of the pages in the site 
describes how to order season tickets for the opera, but you can’t remember where the page is. 
To quickly find the information you want, you could search for the word "ticket," and jump right to 
the page you’re looking for.

Similarly, you might be trying to download a company’s product for evaluation. In that case, you 
could search the site’s WebMap for all FTP services. You can even search the results of a search
to narrow the findings even further.

CyberPilot Pro lets you search WebMaps for specific object types (graphics or program files, for 
example), for text strings, for file sizes or modification dates, or for any combination of properties.
For example, you could search for all HTML pages that contain the word "download" in their title 
tag and that were modified after a certain date.



 Customize NetCarta WebMaps™ for browsing and publication

When you’re using a NetCarta WebMap with your Web browser, you can look at the entire map 
to get an overview of a site, or you can hide certain parts of the map to focus on a particular area.
You can change the labels that accompany map objects to see different information: their 
hyperlink text or their URLs, for example.

If you’ve mapped a site that you visit often, you may want to create notes about particular map 
objects for future reference. When you visit the site the next time, you can search for the notes or
view a note as part of an object’s properties.

Customizing becomes even more useful when you publish a WebMap, either for incorporation 
into your own Web site or for sharing with others. You can include exactly the areas of the site 
you want to highlight; you can create descriptive names for objects and include informative notes;
and you can hide individual branches of the map hierarchy, especially those that have appeared 
elsewhere in the WebMap. You can even publish multiple maps of a site, with each one focusing 
on a different area of interest.



 Keep your NetCarta WebMaps™ up-to-date

Let’s say you visit a particular site quite often, so you’ve created a NetCarta WebMap of the site, 
customizing it with notes about some of the objects. Perhaps you’ve even changed the names of 
some of the objects to be more descriptive. Because large Web sites tend to change often, you’ll 
want to see what’s new in the site without losing your WebMap customizations. CyberPilot Pro 
lets you do just that. You can create a new WebMap whenever you like, generating reports that 
let you know what’s changed in the site since the last time you mapped it. In the process, you 
can update the new map with the customizations from the old one.



 NetCarta WebMaps™ are popping up all over the Web

Many popular Web sites are beginning to feature NetCarta WebMaps. For example, check out 
the Lycos Web site—a popular search site that has cataloged over 92% of the Web—at 
www.lycos.com. (You can also get to the Lycos site from the Net Search area of the Netscape 
home page.) The Lycos site includes a wide variety of NetCarta WebMaps.

The NetCarta Web site, www.netcarta.com, includes a WebMap repository that features a large 
collection of WebMaps; go ahead and download maps you’d like to use. To visit the repository, 
click the Maps button on our home page.

If you’d like to join NetCarta’s hardworking group of cyberspace cartographers and submit some 
of your saved WebMaps to the repository, e-mail them to maps@netcarta.com. If we think 
other CyberPilot Pro users would like to use your WebMaps, we’ll publish them. (Of course, we 
reserve the right to spiff them up a bit if necessary.)

Finally, if you have your own Web site, we encourage you to incorporate NetCarta WebMaps into 
your site. Other CyberPilot Pro users will be pleased with the enhanced browsing experience 
provided by your WebMap, and will be more likely to visit your site frequently. We’ve even set up 
a way that you can automatically display your customized WebMap when CyberPilot Pro users 
come along and try to explore your site. This saves your Web server from being frequently re-
mapped by other CyberPilot Pro users.



NetCarta Technical Support

There are a several way to get help on CyberPilot™ Pro from the Technical Support group at 
NetCarta.

NetCarta Web site

The NetCarta Web site is located at www.netcarta.com. Click the Help button on the home page
to reach the NetCarta Help Desk.

E-mail

Send questions to support@netcarta.com.

Fax

Fax questions to 1+ 408-461-2044




